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This month, I want to talk about three things that I will
group together as a movement. If people had asked me
ten years ago if Linux was a movement, I would have
said yes. Actually, they probably did. The movement I
am going to talk about is not Linux-specific, but it is very
Linux-like in nature. I chose it for two reasons. First, it
may help newcomers understand how Linux happened.
Second, it’s some good stuff you should be aware of.

The three items on this list are: Open Clip Art
Library, Inkscape and Scribus. Before we dive into
Open Clip Art Library, I need to talk a bit about scal-
able vector graphics.

This can be explained without getting a computer
involved. Grab your pencil and draw a straight line
and a circle on a piece of paper. You have just created
two vector graphics. Each can be easily and compactly
described. For example, you need to tell someone
where the line starts, where it ends and how wide it
is. For the circle, its center, its radius and how wide
the outside line is tells someone what it looks like.

We can get a bit more complicated. For example,
the line could be blue or could be made up of dash-
es or dots. For the circle, the inside part could be
filled in with a color.

What is important here is that there is nothing in
these descriptions that will not scale. That is, if some-
one took the description of a 5cm circle with a 1mm

black border filled with red and decided he wanted to
see it twice as big or 100 times as big, there is enough
information to make it look just as nice at the new size.

Contrast this concept with what you see on your
television or computer screen. Here, everything is
composed of a collection of dots. If you magnify the
image, you just end up with the same number of
dots, but each dot is bigger. Thus, if you are going
to have a library of graphics to use, vector graphics
are generally more useful.

That brings us to the first of the three projects I
want to talk about, the Open Clip Art Library. This is
a free and open collection of clip art files that can be
used in anything. That is, they are all released to the
public domain. You can find the collection at
http://www.openclipart.org. The project is in its
infancy, and there are only about 3,500 items avail-
able today, but it has a bright future.

I went out and grabbed the image you see here.
It is titled “Tux is Chilean” and is by Lorenzo Luengo.
If you don’t happen to be Chilean, you likely see the
potential to start with this image and change the
flag to your country or state. Well, good news. The
image is vectors, so you easily can do that, and there
are no licensing restrictions.

If you actually went to the Web site and started
looking around, you probably noticed the filenames
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end in .svg. Why not .eps, .ps, .cdr or .ai, you
might ask? Well, the question is the answer
as well. There have been many vector for-
mats. Beyond that, most Web browsers are
not capable of displaying vector formats. The
World Wide Web Consortium is addressing
this issue with SVG, an open standard for vec-
tor graphics. You can read more about it at
http://www.w3.org/Graphics/SVG.

At this time, there are some applications and
some browser plugins that work with the SVG

format. It is clearly the format of the future. But,
today is today, and you want to do something
with that Chilean Tux. Enter Inkscape.

From the first paragraph on the Inskscape
Web site (http://www.inkscape.org), you can
find this definition: “Inkscape is an open-
source drawing tool with capabilities similar to
Illustrator, Freehand and CorelDraw that uses
the W3C standard scalable vector graphics
format (SVG). Some supported SVG features
include basic shapes, paths, text, markers,
clones, alpha blending, transforms, gradients
and grouping.” I don’t think I need to say
much more other than the fact that Inkscape
can save what you create in a whole host of
formats. Thus, you can start with that Chilean
Tux, change his flag to that of Lower
Sloblovia, convert him to a PNG and send him
to your friend who doesn’t know what an
SVG is (until he reads this article).

That takes me to the third piece of the pic-
ture, Scribus. Scribus is an open-source desk-
top publishing program. Its Web site is
http://www.scribus.org.uk, if you want to take
a look. I have watched Scribus progress from
a very basic layout program to something that
rivals Quark Xpress and Adobe’s inDesign as a
professional tool for magazine layout. In fact,
we are in the process of converting TUX from
the Quark system we have used for Linux
Journal since the beginning to Scribus.

Putting all these pieces together, you have
a source of graphics you can freely use and
two open-source programs. The first is a
graphics editor that uses an open standard

format. The second is a professional-quality
layout tool that uses an open format for input
and produces standard PDF output.

Now, as I said in the beginning, this isn’t
really about Linux, other than you will see, for
example, that Scribus development is happen-
ing on Linux systems. What it is about is that
same type of cooperation that made Linux
itself possible. Early in Linux development, you
saw people all over the world with very diverse
backgrounds contributing to the effort.

If there was a goal, it was to be able to
see that they could put together something
useful. Today, we know that was a success.
But, beyond Linux being a success itself, it
showed that it was possible for a distributed
group of people to work cooperatively to pro-
duce useful software.

That concept, that attitude, is what has
made other projects since Linux move for-
ward. You could assign a lot of labels to it.
One is self-management. That is, there is no
big company or marketing team directing the
effort, but rather, it is people producing what
they feel is needed.

There is a big winner here—you. Efforts such
as these mean there is no more software for you
to buy. In the case of these three projects, they
are free. That doesn’t mean there will not be
commercial products that enter these markets,
but it does mean if a commercial enterprise
wants in, they need to make something better.
Either way, the consumer wins.�

Phil Hughes is Group Publisher for SSC Publishing, Ltd.
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Here at TUX, we get one request more than any other.
People want us to write up a comparison of distributions so
they can choose the right Linux distribution for their needs.
One day, we will do our very best to fulfill that request, but
I want to warn you that it is almost impossible (if not
entirely impossible) to write such an article that will serve
everyone perfectly.

This column is not meant to be a substitute for that article.
It is meant to show that there is a trend afoot that will have a
profound effect on which distribution you will choose in the
future. It starts with a short history of Linux distributions.

Warning: this is not a complete history of Linux distribu-
tions. A full, accurate record would have to include distribu-
tions such as Caldera, Yellow Dog Linux, Turbolinux and many
others, all of which are beyond the scope of the point of this
story. This historical record starts with the time when Linux
finally reached the awareness of corporate customers and nor-
mal users, when Red Hat became king of the hill.

Once upon a time there was Red Hat Linux. Linux lacked
a good graphical desktop. Along came KDE, which was the
most promising graphical desktop around. Red Hat was
already becoming the most popular Linux distribution, but
it decided not to support KDE. Instead, it went with a com-
peting desktop, GNOME. People loved Red Hat but pre-
ferred KDE instead of GNOME. So an enterprising group of
people started Mandrake Linux, which was basically Red
Hat Linux that used KDE as the default desktop. Mandrake

thrived because it gave people everything they wanted at
the time—Red Hat plus KDE. Eventually, Red Hat caved in
to pressure and began offering KDE.

Somewhere in this history, SUSE began to accumulate a
following. SUSE was neither Red Hat nor Mandrake, but it
was a high-quality distribution that offered KDE. So it gained
a reasonably good following. The one thing in common
between Red Hat, Mandrake and SUSE is that they all used a
package format called RPM. This did not make these distribu-
tions compatible. You could rarely install a SUSE package on
Red Hat or a Red Hat package on SUSE. At first, you could
install Red Hat packages on Mandrake and vice versa, but
that changed quickly. So the fact that all three used the same
package format became essentially meaningless.

THE RISE OF DEBIAN
Debian is a distribution of Linux that uses an entirely differ-
ent package format than Red Hat, SUSE and Mandrake.
Debian uses what is usually referred to as .deb packages.
There is nothing about .deb packages that make them more
universally compatible than RPM packages. So if you build
two different distributions using .deb packages, they can be
just as incompatible as Red Hat is incompatible with SUSE.
The one advantage that .deb packages had over RPM pack-
ages is that Debian included a program called apt, which
made it incredibly easy to find, install and update packages.
(Red Hat and other distributions later added this ability in

An Evolution of Linux Distributions
Comparing distros is like comparing shoes—if it fits, use it.

NICHOLAS PETRELEY

FROM THE EDITOR IN CHIEF
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the form of apt for RPM and a program
called yum, but that came much later.)

Some companies saw many advan-
tages to using Debian as the basis for
their commercial distributions. Corel
based its first distribution on Debian.
Thanks to a big payoff from Microsoft,
Corel sold its distribution and the distri-
bution has now become Xandros. Other
groups and companies tried to create
unique distributions based on Debian
(Progeny Linux is one example that
comes to mind). They found that it was
to hard to make money that way. I sug-
gest that it is because their spin-off of
Debian was too much like Debian itself.
It was far too easy to turn Progeny
Linux into a standard version of Debian
Linux. After that, you didn’t need
Progeny anymore.

Since then, there have been many
more spin-offs based on Debian. These
include Knoppix (with a default KDE
desktop), Gnoppix (with a default
GNOME desktop), Ubuntu (default
GNOME desktop), Kubuntu (default KDE
desktop), Mepis, Xandros, Linspire and
others. Most of these distributions either
“accidentally” deviated from Debian so
much that it is difficult to turn them into
standard Debian distributions, or they
deviated from Debian on purpose to
make sure you keep using their distribu-

tion instead of converting to pure
Debian. I recall turning Knoppix into a
standard Debian distribution once. But I
tried it again recently, and it was so
much trouble that I finally gave up.

Mepis is another distribution that is
based on Debian. I get the impression
that it is, at least in some ways, closer to
being true Debian than Knoppix. But it
has a number of silly design flaws that I
find to be very annoying. I have installed
Mepis three times, and twice I have made
silly mistakes during configuration that
made the installation unusable and too
difficult to recover to make recovery
worth the effort. Granted, they were my
mistakes. But aren’t programmers sup-
posed to write software that prevents
people from making such mistakes? That
is what computers are good at doing—
detecting combinations of settings that
do not work together and telling the user
that something must be changed other-
wise the computer will not make the set-
tings permanent.

WHEN DEVIATION IS GOOD
Sometimes the deviation from pure
Debian has turned out to be a very good
thing. Ubuntu/Kubuntu are more recent
spin-offs of Debian. They get one very
important feature right that I have never
seen with any other distribution. You are

never asked for a root password (adminis-
trator password) when you install
Ubuntu/Kubuntu. You cannot log in as
root or the administrator. This means that
unless you know Linux well, it is nearly
impossible for you to damage your sys-
tem by accident. (If you know Linux well,
it is actually very easy to bypass the
Ubuntu protections, but the assumption
of TUX is that you are a new user and will
not know how to do this.)

Ubuntu and Kubuntu have draw-
backs, too. These distributions are
mostly incompatible with pure Debian
software. If you want some software
that is available from Debian but not
from Ubuntu/Kubuntu, you either will
have to find the source code and com-
pile it yourself (not a viable option for
a new user) or just wait until the
Ubuntu/Kubuntu folks add that soft-
ware to their repositories. Perhaps the
most annoying thing I personally expe-
rienced after installing Ubuntu was that
it was stuck on version 1.0.2 of the
popular Firefox browser. At that time,
Firefox 1.0.4 was available. The reason
this was annoying for my purpose is
because many Firefox extensions I use
(such as one that lets me synchronize
bookmarks) will not work with version
1.0.2. I know there are some
workarounds available, but I don’t
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want workarounds, I want Firefox 1.0.4
(or 1.0.5, which was just released).
Maybe Ubuntu/Kubuntu has corrected
this poor choice since I installed the
software, but it was a terrible nuisance
at the time.

Take Linspire as another example.
This issue includes a review of Linspire.
There’s no question about it. Linspire is
the ultimate desktop distribution for
nontechnical users, especially those
who are coming from a Windows envi-
ronment. Linspire offers many enhance-
ments that make it far more desirable
than plain Debian.

AN INSPIRED DEVIATION
Some people may cringe at the thought
of paying Linspire a yearly subscription fee
to use a specially designed program called
Click-and-Run (CNR) to download soft-
ware, some of which is free to everyone
else. Personally, I think this is a non-issue.
It sounds like Linspire is adding a price to
free software, but that’s not what Linspire
is doing at all. In return for the $50 (or
some much lower yearly price Linspire is
considering for the future), you can use
Click-and-Run to browse through avail-
able software more easily than anyone
else, and you get steep discounts on
many commercial software packages. You
can install software with a single click of

the mouse. Even if the free package man-
agers for Linux (such as Kpackage or
Synaptic) ever get as sophisticated as
Click-and-Run, it will be difficult, if not
impossible, for free distributions like
Debian or Fedora to make discounts avail-
able for commercial software unless they
stop being free. You need to charge a
yearly subscription fee to afford the luxury
of making deals with commercial compa-
nies to offer discounts.

There is, of course, a trade-off you
have to make with any distribution that
“improves” your desktop experience by
modifying the KDE or GNOME code.
Both Linspire and Xandros use an older
version of KDE, because they modify
whatever version is available at the
time. The latest version of KDE is 3.4.1.
Linspire uses KDE 3.3.2 and Xandros is
still stuck on KDE 3.3.0.

If any distribution threatens to come
close to offering the convenience of
Linspire, it is Xandros. But it is a hollow
threat at best, and by “comes close” I
measure it in light years. Xandros has
the right idea, but it still has way too
many deficiencies and problems to be
comparable to Linspire. Their equivalent
to the subscription download services
just doesn’t match the user-friendliness
or convenience of Linspire’s CNR. And
Xandros modifies the boot loader in

such a way that it can fail for anyone
who runs multiple distributions (Xandros
is meant for those who want only one
distribution, so this probably isn’t an
issue for most people).

RED HAT RISES AGAIN
Statistics now show that Debian and its
spin-offs are growing faster than any
other distributions. The folks at Red
Hat are many things, but they are not
stupid. They created Fedora, an open-
source version of Red Hat equivalent to
the Debian approach to Linux, before
anyone reported any statistics about
how the tides were turning toward
using Debian as the basis for new dis-
tributions. Red Hat hopes that more
people will use Fedora as the basis for
free and commercial distributions and
fewer people will use Debian as the
basis for free and commercial distribu-
tions. Any incompatibility with Red Hat
(and Debian is entirely incompatible) is
bad for Red Hat. Any compatibility with
commercial Red Hat Linux is good for
Red Hat. So if more people start with
Fedora as their foundation, Red Hat
potentially benefits. Whether or not
spin-offs of Fedora start to appear
remains to be seen.

Meanwhile, there is Fedora itself. I like
Fedora a lot. If you have not tried it and

P2P

7www.tuxmagazine.com

http://www.tuxmagazine.com


you are still looking around for a good
distribution, I strongly recommend that
you do try it. It might just be the distribu-
tion for you. It isn’t an easy task for most
people to try Fedora. You can download
five CD images and burn them yourself
(one CD is a rescue CD, and you may not
want to create that one). I am sure you
can order CDs from various sources for
very little money. But it is not a commer-
cial distribution, so you can’t get a fancy
box with a manual and so forth.

THE BIG CHOICES
Let us finally consider the last big
three. Yes, I know I will get hate mail
for failing to mention someone’s
favorite, such as Slackware, Gentoo
and others. But we editors are used 
to getting hate mail; it comes with 
the territory. So, I will insist that the
big three are as follows: Red Hat, 
SUSE and pure Debian.

First of all, commercial Red Hat is
not a desktop operating system. So if
you are a true TUX reader, you should
not be considering Red Hat for the
desktop. ’Nuff said. I am sorry to say
that I have disliked SUSE for so long

that I am not the least bit motivated to
try it again. The latest version I have
tried is the latest free version for down-
load, and I still didn’t like it (at least it
was the latest as of a month or two
ago). If someone from Novell wants to
send me a commercial SUSE box for
review, I’ll install it and write about it.
Until then, I have to go with my former
impressions and say that I don’t like it. I
know a lot of people who practically
worship SUSE, and maybe they have a

good reason for doing so. Maybe you
will love it and find out it is the best
desktop on earth. But I cannot reassure
you that this is what you will experience
because I have never liked it, myself.

Finally, there is plain-old pure
Debian. Debian is not nearly as hard to
install as it used to be. But Debian is
still much more suited for geeks than it
is for desktop users. Nevertheless, of all
the distributions I have used, Debian is
still my favorite. Debian has three
branches: Stable, Testing and Unstable.
The Stable branch includes software
that is so old it needs a walker to get
started. The Testing branch includes

software that has not been proven to
work perfectly, but at least it includes
some more recently released software. I
use the Unstable branch. Despite the
name, I have found the Unstable
branch to be quite stable, and it has
the most recent software of all three
branches. It doesn’t have the most
recent software of all, however. You
have to add some unofficial reposito-
ries to get things like KDE 3.4.1, for
example. That is why Debian is a geek-
oriented solution. Typical newbie users
don’t want to add repositories they
never heard about.

CONCLUSION
Well, there you have it. The above is
certainly not the definitive comparison
of distributions, and it is lacking in
some areas (especially information
about SUSE). But I hope it has enlight-
ened you to some extent about how
the current trend is to use Debian as
the basis for desktop distributions. This
trend, if it continues, might eventually
help you choose one distribution over
another. Good luck!�

TUX Editor in Chief Nicholas Petreley is an author,
consultant, programmer, award-winning columnist
and Linux analyst for Evans Data Corp.
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TUX Delivers
In issue 3, someone talked about how easy Linux
networks with other platforms. As a new Linux
user networking, even to other Linux machines,
has escaped my abilities. How about an article on
how to network while using Linux?
--
nelson

This very issue contains an article on how to
access Windows shares (page 38). How’s that for
service?—Ed.

Which Distro?
I would describe myself as a “Potential Linux
User” in that I would like to start using it, but
haven’t yet. I did download the Debian OS and
tried to install it, but I have to admit I gave up
when it wanted me to choose all the applications
(I believe) to install—I didn’t have a clue! Anyway,
my suggestion is a poll akin to this:

“What distribution would you recommend to
potential Linux users, given that the main objec-
tive is to give them the best chance of a ’hassle-
free’ install and set up and keep them interested
enough to try other distributions?”

I have tried asking that question before, but it
seems that the answers are either:

1) Use XXXX (based on the reply being from
someone who is using XXXX).

2) Choose anything—if you don’t like it, then try
something else.

The problem with 1 is that it is not really very
objective (like a poll might be), and 2 definitely
doesn’t help—I haven’t looked at Linux since my
Debian introduction six months ago! Regardless,
thanks for the magazine.
--
Alan

Alan, on-line polls are generally the least objective
of all, and you’re likely to get the same answers
you listed as 1 and 2. See this month’s “From the
Editor in Chief” for a short take on where distribu-
tions are going and the admission that it is diffi-
cult to recommend one without considering each
person’s expertise and needs. By the way, Debian
is much easier to install now. You don’t have to
select individual packages if you don’t want to,
but the installation still isn’t perfect.—Ed.

Desktop Linux?
In the business desktop market, most studies
show that the reason Linux still lags behind isn’t
quality or cost of purchase, but that the cost of
implementation is prohibitive when it comes to

downtime, that is, frustrated users, expected to be
technically advanced enough to use Linux, instead
of Linux being technically advanced enough to be
intuitive. Linux is just not a neophyte’s starter sys-
tem. [...] My very successful friend Bob Robson of
Robson communities, who is worth well over 100
million dollars says, “I don’t want to know how it
works, I just want it to work.” [...]

The good news is that Linux developers are start-
ing to realize this; just check out Sun’s bold move
of its new Java desktop system: http://www.sun.com/
software/javadesktopsystem/index.xml. I know
guys that refused to use Lindows, Xandros or even
SUSE, because they felt that they were MS clones.
I feel more like we are just coming into the times.
Besides, we are not copying MS, we are copying
MS’s copy of Mac’s copy of XEROX.
--
Brandon Thomas

Games, Please
I am a semi-experienced Linux user. I have been
dual-booting SUSE/Windows for a few years now
and use a Sharp Zaurus 5500 PDA (greatest Linux-
based PDA ever). My problem, as well as that of
many people I know, is that I enjoy my PC games.
This has kept me tied to Windows. I know that
Cedega by TransGaming is making leaps into solv-
ing this dilemma. I intend to make my next PC
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(building sometime this summer) 100% MS free
and would like to see TUX magazine’s take on the
gaming aspect. Do you all intend to check that
out in the future?
--
Benjamin

Yes, we have definite plans to cover gaming on
Linux in future issues!—Ed.

Thanks, from the Dominican Republic
Hello, I’m Valmis Di Carlo from the Dominican
Republic. I have all of your excellent magazines.
Thanks for TUX magazine. TUX is very important
for GNU/Linux users in the Dominican Republic;
here, all my friends read TUX. TUX is very essential
for new users of personal computers.
--
Valmis Di Carlo

Tomboy Works with KDE
I want to thank you for TUX magazine. I have
enjoyed every issue. I have been a Linux user for
many years, using Mandrake, SUSE, Knoppix and,
lately, Mepis distributions. I have also recommend-
ed your magazine to my friends who are newbies.

I wanted to comment on Shannon Baker’s arti-
cle on Tomboy in the July 2005 issue. I have
decided to give it a try to see if it might help
with those “quicky notes” that I like to take.
Baker states, “Tomboy is a GNOME application.
Although I am sure some longtime Linux users

out there could make it work with KDE, I have
not been successful.” Well, I have gotten it to
work with KDE.

Since I’m currently using Mepis, I first installed
Tomboy using apt-get (apt-get install tomboy).
Then in KDE it is available from the K (start) menu
under Utilities→Tomboy (Desktop Notes). To make
it start automatically upon login, open the
Konqueror file manager (the Home icon). If you
do not see the “hidden” directory .kde, choose
the View menu and check “Show Hidden Files”.
Navigate to the .kde folder and then into the
Autostart folder. Right-click in the empty area of
the right pane and choose Create New, then File,
then Link to Application. On the General tab in
the area that says Link to Application, replace this
with Tomboy. On the Application tab, enter
/usr/bin/tomboy in the Command field. If you
wish to change the icon, go back to the General
tab and click on the big icon. Change Icon Source
to Other icons, and then scroll down through the
selections. You should see an icon for Tomboy.
Click on that icon, and you’ll be taken back to the
General tab. Click Ok. You can now close the
Konqueror file manager.

The next time you log in, the Tomboy process will
be started in your start-up tray, ready for use!
Thank you again for the great articles!
--
Jon Du Quesne

Thanks also to Philipp Wolfgang Leitner who sub-
mitted another method to make Tomboy work in
KDE. We chose not to print that letter since it is
somewhat redundant.—Ed.

Drivers for Linux?
As Nicholas Petreley points out, one of the
main limitations of Linux is the lack of drivers
written for Linux. I have two computers, but
I’ve installed Linux on only one. The other has
a USB wireless adapter that connects to the
Internet. It’s a NETGEAR WG121, which doesn’t
have a Linux driver. I lack the skill to develop a
wrapper, or whatever it’s called, for this driver,
so I just have to stick to Windows XP.

I’d like to encourage TUX to start to maintain a
list of devices that are Linux-friendly. This would
be a great benefit for newbies like me.
--
Tom Strickland

There is a workaround that allows you to use
Windows drivers to get network cards running
under Linux. It is called ndiswrapper and works
very well for many cards. Newbies may be
intimidated by what it takes to use ndiswrapper,
but we plan to do an article on it because it
really makes a huge difference in the number of
network cards available for Linux.—Ed.
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Reports?
I noticed in your discussion of what is or is not
available for Linux, business/accounting apps were
mentioned, and following up, a review of Quasar
mentioned a shortcoming being the inability to
modify the reports [June 2005]. Is there a report
writer environment similar to (and hopefully not
so damn quirky as) Crystal Reports that runs on
Linux? And, is there an ODBC equivalent?
--
Bob

We don’t know of much out there that fits this
description. Kugar is a KDE report designer and
generator, but we’d have to ask someone who
knows about this type of software to find out if it
does the job you want. Are there any readers out
there who are using a report generator under
Linux? Let us know!—Ed.

Hey TUX, Stick to Linux
I just got the latest issue of TUX and read the let-
ter titled “Opinions” written by Bashar [July
2005]. I know that some people got offended by
some of Mango’s remarks and then she apolo-
gized. She was just joking around. However,
Bashar’s letter is filled with venom and hate! I
don’t see how his letter fits into a Linux magazine.
It is the most out of place item I have ever come
across in a publication. You seem proud that you
published his whole letter. Again, Mango was jok-
ing and apologized. Bashar is spewing hate. I
won’t comment on his opinions; he is entitled to

them. But, I cannot understand why you pub-
lished it. What does his letter teach me about
Linux? I am seriously considering canceling my
subscription.
--
Michael Paley

We published it only to balance the kudos for
Mango. But you are right—we will make a 
concerted effort to stick with Linux topics in
letters.—Ed.

OpenOffice.org
I have considered switching from Microsoft
Office XP and 2000 for some time—here is
what has held me back so far. In business, I
constantly write reports. I have played with
OpenOffice.org (Windows version) and like the
operability compared to MS Word, but I have
read that spell check is not very good. I assume
that you must publish your magazine using a
Linux word processor. Do you have a solution?
--
Mike Williams

We have had nothing but good experiences with
spell check, so we’re not sure what problems
you are experiencing or have heard about.
OpenOffice.org 2.0 is due out soon, and it has
major improvements. Perhaps that will be more
suited to your tastes.—Ed.

XMMS
You know if you right-click on XMMS→Options, it
lists quite clearly Ctrl-D, double size, under the
menu. No need for a magnifying glass or ESP to
read the displayed bumps. I thought everyone
knew this!

My question is this, is it “Zimmz” as my wife pro-
nounces it, or “X M M S”?
--
Gav

I have no idea how the authors pronounce it, and
I didn’t see anything about it in the XMMS Web
site FAQ. But, for what it’s worth, I pronounce it
“Oglethorp”.—Ed.

Help with Installing
The article by Phil Hughes was a nice little note on
how easy it could be if you just want Linux to be
used as a desktop OS [July 2005]. It took less then an
hour to install and start using Mandrake Desktop 10.

I am trying to learn PHP programming. Installing
software like this is not an easy task, I found. It
needs so many configurations to be modified that
I have not been successful in installing PHP. I have
been struggling to install Apache, PHP and MySQL
on my Mandrake 10.

It took 4–5 hours for me to learn how, and what
files, to modify in order to install Apache, but when
it came to PHP, I just gave up learning how to install.
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I tried with Sun Solaris 10 before installing
Mandrake. It took ages to install the OS, but
Apache was easy to install, all preconfigured, but
it was not the same story with the installation
of PHP.

I would appreciate it if someone could cover soft-
ware installation, especially those that require con-
figuring and changing some filenames, moving to
different directories and so on.
--
Manish Parmar

Different distributions handle installation of things
like Apache and PHP differently, some better than
others. I’ve had mixed results installing Apache,
PHP and MySQL, but at least two distributions
made the process a breeze. I wish I could remem-
ber which ones they were. If it comes to me, I’ll
mention it in my column.—Ed.

Tomboy
In the July 2005 issue of TUX you talk about a
program for GNOME called Tomboy. Is there an
application for KDE that will provide the same
functions as Tomboy?
--
Andy

Not exactly. I use a KDE application called Kjots,
which is great for recording and organizing notes. I
prefer it to any type of post-it notes-based tool.—Ed.

John Knight on Piracy
In the July 2005 issue’s “The Last Word”, John
Knight makes many statements that demand more
careful thought. He seems quite happy to apply the
label of “Pirate” to people who violate EULAs by
making and distributing copies without payment to
the copyright holders. At http://www.gnu.org/
philosophy/words-to-avoid.html#Piracy, the
issue of whether to accept this term is dealt
with like this:

Publishers often refer to prohibited copying as
“piracy”. In this way, they imply that illegal
copying is ethically equivalent to attacking
ships on the high seas, kidnapping and mur-
dering the people on them.

If you don’t believe that illegal copying is just like
kidnapping and murder, you might prefer not to
use the word “piracy” to describe it. Neutral
terms such as “prohibited copying” or “unau-
thorized copying” are available for use instead.

Some of us might even prefer to use a posi-
tive term such as “sharing information with
your neighbor”.

It is difficult to equate unauthorized copying with
plunder and murder, but it is unethical, nonethe-
less. An end-user license agreement is still an
agreement, and violating it, at the very least,
undermines one’s integrity.

Now, let’s consider the rest of his statements.

If cost alone were the motivating factor [for pira-
cy], free (as in speech) software, which is easily
had at zero cost, would have overrun proprietary
software already.

[...] Often, an overpriced item is desirable to a
buyer simply because it is unaffordable. It’s the
ego factor. Since software is so easily copied, it is
easy to see how a high price helps create a desire
for it in the minds of consumers. Both Microsoft
and Adobe were willing to overlook unauthorized
copying for many years in order to set their pro-
grams up as ubiquitous standards.

But, he continues pressing this point beyond the
limits of reason, claiming that unauthorized copy-
ing “removes the cost factor, leaving the biggest
and best as the only viable choice.” What a
mouthful. First, he implies MS Office and Adobe
Photoshop are the best, and then suggests that
because price is not a factor [if you pirate copies],
that consumers are left with no choice but to use
those two packages! That’s some logic—that
given the removal of price as an obstacle, con-
sumers will be forced to use one free-as-in-beer
package over another.

He says that because [Photoshop pirates] did not pay
for Photoshop “none of them are able to make a
proper comparison” of it to The GIMP, which need

P2P

12www.tuxmagazine.com

http://www.gnu.org/
http://www.gnu.org/philosophy/words-to-avoid.html#Piracy
http://www.tuxmagazine.com


not be paid for. Their ability to think is somehow
impaired by getting the fantastically ultra-superior
Photoshop for nothing. And it’s outrageous!

“Unpaid volunteers are competing against paid
software designers and are being unappreciated
by the masses.” He is implying that different stan-
dards should be applied when evaluating propri-
etary versus free programs.

Sure, unauthorized software copying should be
stopped. Yes, we should resist giving it to our
friends (assuming we even have any to give—soft-
ware that is, not friends). And yes, it’s easy to see
software “piracy” as hurting open source.

However, we should definitely hold all software to
the same standards of quality, whether proprietary
or free. And we should be willing to give people
more credit for intelligence than John Knight seems
willing to do, by allowing that their thinking will not
be impaired by the unstoppable force of zero cost.

[...] He is right when he says “a proper view of
open source is the right alternative to piracy”,
but then promotes a distorted view of the
forces driving unauthorized software copying,
mis-characterizes the quality of both free and
proprietary software, and completely discounts
the intelligence of users.
--
Scott Bicknell

More John Knight on Piracy
Outstanding! Great article—cuts right to the heart
of the issue, without unnecessarily defending
MacroShaft, or whatever the name is. I have at least
one very good friend who is/has been part of the
M$ developers network, and this is an article we
can both agree on. The sooner everyone who uses
M$ products can be dunned for the “benefit”
they’ve received, the sooner M$ will lose major mar-
ket share to open-source products. That, in turn, will
create a much larger base of expertise in the Open
Source community, and the wheel will turn!
--
handydan918

Pizza, Anyone?
In Phil Hughes’ article on living in Linux (“Easy
Does it”, July 2005) he laments that there is not a
way to make food in Linux. He has missed out on
one of the most geeky programs out there:
pizza_party. This is a command-line tool for order-
ing pizza. For instance:

pizza_party -pmx 2 medium regular

That orders two medium regular-crust pizzas with
pepperoni, mushrooms and extra-cheese. I tried
it. Thirty minutes later a delivery guy showed
up with two pizzas. It works. This is the URL:
http://www.beigerecords.com/cory/pizza_party. So
now you can do ANYTHING in Linux, Phil.
--
Chuck Graf

SimplyMepis
I just wanted to let Bob [from the July 2005 issue’s
Letters] know that I’ve just installed SimplyMepis on
a machine with Windows 2000. I installed on hdb
(which for me was a separate HDD) and then
installed GRUB in the hda MBR (which is the
default). I have never done anything like this before,
and...it worked. So, Bob, back up everything and, as
Australians like to say “have a go, mate!”

ED: if you can let him know to check out the
mepislover site, he’ll get really good support to
any questions he asks.

Well done all TUX’ers.
--
Patrick Elliott-Brennan

Text Size
GREAT MAGAZINE! Tell your reader L. D.
Matteson [Letters, July 2005] who complained so
loudly about not being able to adjust text size to
scroll down and read Adobe instructions. It’s so
easy; just press Ctrl+. You can get text as large 
as you want. Some old farts (I’m one) just like 
to complain.
--
Richard Davies

Stop OS Discrimination
I’m by no means a computer professional; in fact,
I’m a chemist. I am, however, a raging computer
nerd and Tux-o-phile. I am in charge of the com-
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puters in our lab (and a couple of Web sites), and
I have dropped Fedora Core on one of the lab
computers, which people have really taken a liking
to—especially after two WinXP boxes crashed and
almost took someone’s thesis with it (I had to
boot a live Linux CD to recover the data too). I
ditched Windows (except for non-Cedega-compli-
ant games, grumble, grumble) a while ago and
run Gentoo on my laptop, FreeBSD on my work
desktop, Gentoo on my home desktop and Fedora
Core 4 on my home “server”. I preach Linux (and
FreeBSD) to all who will listen and have discontin-
ued my “free technical support” for Windows (I
refuse to fix Windows computers at work any-
more). <obligatory plug> I love your magazine
because I can recommend it to the neophytes
around here, and I agree 100% with Phil Hughes’
take on “Can Anyone Use Linux?” in the May
2005 issue. That is, my Windows “Power User”
friends are impossible to turn to the Penguin side,
but most people don’t even notice they’re using
Linux when they log in to the Fedora box in the
lab (yes they are that clueless), and many have
asked me to help them install Linux on their per-
sonal computers after using Fedora. Anyway, I
read Linux Magazine and Linux Journal, but they
are geared toward professionals (not that I don’t
learn a lot from reading them). I really appreciate
your approach to Linux advocacy through journal-
ism, and I hope you stick around for years to
come.</obligatory plug>

Today though, there is a thorn in my flipper:

the Web. A few years back, when Internet
Explorer dominated the browser market (more
so), there were a lot of “IE-only” Web sites.
This, as I understand it, was attributed to the IE
engine, which had a “special” (read: non-stan-
dards-based) way of rendering certain—espe-
cially JavaScript-based—pages. This has been
curbed in recent years, especially since the Mac
version of IE was discontinued and Firefox
showed up on the local news (or as we call it in
LA, gossip). But recently I’ve seen a resurgence
of this unforgivable behavior. I pointed my 64-
bit Gentoo/Firefox/Plugger/Mplayer setup at a
variety of news sites and sites that offer pre-
views, clips and whatnot from TV shows, and
found that none of the streaming video
worked. I stuck my nose into the page source
and found that it was detecting my browser as
“Netscape” (or Gecko) and my OS as “other”
and thus denying me Windows Media (WMA)
streaming formats. I switched my browser ID 
(I love Firefox) and the site detected me as
IE/Windows, but still no streaming. I edited my
plugger config file to use mplayer32 and
installed every Win32 CODEC I could get my
hands on, tested it with WMA files and simple
embedded media, and everything was fine.
Heading back to these sites, I again was con-
fronted with a blank white box. I repeated the
exercise on my 32-bit laptop, different Linux
distros—nothing. After digging around on the
Web, it seems that JavaScript-based “stream-
only” sites (that is, sites that prevent download-

ing of the media directly) simply do not work
with Linux (well, with Plugger, but what other
choice do I have?). You guys have touched on
the reason for wide-spread Linux adoption
“behind the scenes”—that the switch from
UNIX was natural and painless—that has led to
most of the Web being run on BSD or Linux sys-
tems, but the irony remains. Much of the front
end of the Web is still Windows-only. I gather
this is the result of Microsoft positioning WMA
as the de facto standard in streaming multime-
dia, which is only going to get worse if the EU
patent laws go through, but this sort of nefari-
ous behavior could cripple Linux desktop adop-
tion if it is not stopped.

With broadband spreading like wildfire, more
and more sites are offering streaming multime-
dia content. I’m having to answer to my
Windows Power User friends who point and
laugh when I can’t stream Yahoo News or clips
from the Daily Show with Jon Stewart. If there
is a way to make Gentoo (or any Linux distro)
work correctly with this rapidly spreading
implementation of streaming multimedia,
PLEASE TELL US! If not, we nerds have to start
a public-awareness campaign to end this OS
discrimination before Microsoft delivers the
death blow and forces us to run Bloat-, I mean,
Long Horn, inside a virtual machine just to use
the Web—Our Web.
--
Ryan Chiechi
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We agree this is an extremely important topic. We
will do our best to deal with streaming video over
the Web in a future issue.—Ed.

Believe
I stumbled upon TUX magazine about a month
ago at a very interesting time. Almost ten years
ago now I started my professional writing career
with you when you headed up Linux Journal. For
the last ten years, I’ve remained orbiting the Linux
world while solidly rooted, lately, in Mac OS X.

Recent developments in the direction taken specif-
ically in Mac OS X 10.4 caused me to begin a pilot
project to see if I could effectively and productively
use GNU/Linux on a day-to-day basis. TUX
dropped onto my radar at that exact moment,
and I was very happy with what I saw.

I am a new member of the Ithaca Free Software
Association. The Association exists to support and
promote Free Software within the community and
has had such successes as building and giving
Linux computers to community youth as well as
starting a significant Linux presence in the local
school system. I am highly recommending your
magazine to this group in helping with its mission.
The magazine is filling a vital niche.

Truth to tell, my recent experiences have not
pointed to the conclusion that Linux is ready for
normal people to use. It took me two weeks to
get a wireless card working on an Inspiron 7000

laptop, and this involved several kernel recom-
piles—something that we simply cannot expect
normal users to do. I look forward, however, to a
monthly argument from TUX magazine in convinc-
ing me that the Goal is not lost. I Want To
Believe!
--
Richard Kinne

Hang in there, Richard. Driver support is improv-
ing, but slowly.—Ed.

Multiple Distros?
Thanks for putting out such a great resource for
Linux beginners like myself. In the first issue,
Nicholas Petreley mentioned all of the Linux dis-
tros he has running on his box. I couldn’t help but
drool, because I have been researching how to
install multiple Linux distros for seriously over six
months. Only a few articles address a Linux-only,
multiple-boot setup. It seems there are many ways
to do it, and I’ve gotten thoroughly confused.
Also, I don’t have nearly enough experience to
put together all the useful bits of information and
apply them to my needs.

So, what I am requesting is a straightforward,
authoritative guide to installing multiple Linux dis-
tros. I think this would serve many beginners by
allowing us to explore many distros without hav-
ing to un/install every time we want to try some-
thing new.

Thanks and keep up the good work!

PS. I have no idea if this is true, but I have the
impression that installing multiple distros was so
2000—like there was a period of time when peo-
ple figured out how to do it and now no one real-
ly talks about it anymore. Or maybe I just have
crappy Google searching skills.
--
John

Thanks for the Free Subscription
I thought it might be of interest how I happened
to acquire a copy of your fine magazine (digital).
Like many digital-hungry individuals on a limited
budget, I often look to torrents to find maga-
zines. Although some would consider this theft,
I feel the cost of the magazine is due to print-
ing, and the advertising pays for the company’s
expenses. If it’s digital, then costs are reduced.
In exchange, however, I try to take the time to
write to advertisers if I feel their ad (in a maga-
zine) helped me to make a purchase. Never
using this system have I seen a magazine that
freely offers its subscription digitally (something
I feel all magazines in the computer field should
do). Thank you for doing so.

In closing, I would like to say I originally down-
loaded your magazine because of a budding inter-
est in Linux. Like your editorial opening, I’m not
interesting in building, but rather in being an end
user. Your magazine is the only one of its kind I’ve
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seen that fills that void.

PS. I’m very interested in the Pepper Pad due to
your magazine.
--
Mike Smith

Wireless Options
I’m just starting to check out the wireless options
for my FreeBSD box and thought that you might
find this link interesting if you commission an
article on wireless: http://www.mervin.net.au/
wireless/template/index.php.

TUX is da wheel in the wheelhouse. The com-
pass is dead on, the radar enlightening and the
format outstanding.
--
Henry Kaminski

Yay TUX
What a wonderful magazine—at last, a magazine
about Linux I can understand. I wish there was
something similar dedicated to my BMW R65
transport system.

Anyway, I’m happy you guys exist and have put
something understandable together for all the
reasons you have already mentioned in your
first issue.

I stumbled on TUX accidentally, and feel only now
that I belong to the Linux community, because

there are others speaking my language about
Linux. My Internet searching has been reduced
considerably.

I’ve been trying to use Linux on and off for some
time now, with mixed results, but recently I bit the
bullet and said farewell to Bill on my Toshiba lap-
top. I have two computers—a laptop with
Mandrake 10.1 and a desktop with XP. I have to
have this as I bring a lot of work home.

What I’d like to learn about is how to get these
two computers connected; when I was using the
laptop with XP Pro and the desktop with XP
Home and a simple crossover cable, it was quite
simple and worked fine. But I cannot get it work-
ing now with Linux on the laptop, simply because
I just do not know enough about Linux yet.

But I’m sure you will cover this kind of issue in
TUX sometime in the future, and I shall wait
patiently.

I read the other letters and comments, and I wish
some would have a little patience for TUX to
develop further, before starting their bashing. Hell,
I bet they are not perfect.

There is nothing wrong with the layout or the rea-
son for the style/format. Some of us just have to
work a little harder to get what we want; you
cannot please everyone all the time. I have no crit-
icism, just praise and thanks for thinking of us

“Linux eager-to-learn chaps”.

After all, it’s free, isn’t it? Let those who wish to
complain, do so when they are paying for it, in
the mean time don’t spoil it for us, be quiet,
read, learn and contribute by giving the authors
ideas and don’t force the authors to start getting
too geeky.

Thanks, TUX magazine, you are doing us a favour,
a very good service and we are grateful. Eagerly
looking forward to the next issue.
--
Darryl

More GNOME?
I think that you have a great publication in TUX,
and I can see a lot of potential in the magazine.
One thing I noticed though is that you guys seem
to review a lot of KDE-based apps. I’m guessing
that is your preference, which is cool, but I was
wondering if you could also include some articles
and screenshots of GNOME apps and desktops. It
would be great if you could.
--
Cecil

It isn’t our preference that matters. KDE is the
preference of most new Linux users, the target
readership of TUX, which is why we cover it more
than GNOME.—Ed.�
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Hello again to my many friends who
send questions. There are many excel-
lent questions this month. They are, of
course, followed by my even more
excellent answers. Maybe you do not
think my answers are excellent, but you
will say so anyway. Nobody wants to
insult such a humble, pretty girl.

I am sorry to remind you that I do
not answer e-mails directly. I select
questions and answer them here. I did
send a couple of questions to the editor
in chief for him to answer directly. Just
between us, I am trying to make more
work for him to do as revenge for over-
editing my columns. [Don’t worry,
Mango, I’ll keep it a secret.—Ed.]
Maybe someday he will get the hint.
Now, on to the excellent questions.

Q I like the look of KDE, but I have
never mastered manipulating the

menus. I don’t like a desktop cluttered
with icons—and I have been using
GNOME (Red Hat 9) because it makes
available “drawers” to hold my program
icons in groups I choose. Mostly I ignore
the menu icon in the left corner of the
panel and select my programs from the
panel drawers I’ve created. So, how
would I make groups of programs avail-
able from the KDE panel without a lot of
clutter?—Harry Bump

A If you do not use a very old 
version of KDE, it is easy to make

a “drawer” of your favorite applica-
tions in KDE. KDE calls this drawer a
QuickBrowser. It works like a drawer.

It takes a few steps to make a
QuickBrowser. Number one: right-click on
the KDE desktop and select Create
New→Folder... from the pop-up menu.
Name this folder Apps or some other
name you like better. Open the new folder.

Number two: go do number one if
you had too much coffee this morning.
Are you back? Okay, then do number
three: click on the main menu for KDE
and select (highlight) the menu item for
an application you like to use often. If
you click on this selection, it will start the
application. Do not do that. Do this
instead. Click on the selection and hold
down the mouse button. Drag the selec-
tion to the empty space in the open
Apps folder. Now let go of the mouse
button. You will see a little pop-up
menu. Select Link Here from the pop-up
menu. Now you see a link to your
favorite application in the Apps folder.

Do this again with a few more of your
favorite applications. Now you can close
this folder window if you want to. It
doesn’t matter.

Drag the Apps folder icon to a spot
on the panel where you see other icons
to start applications. A pop-up menu will
show up. Choose Add as QuickBrowser
from the pop-up menu. Now click on the
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Apps folder icon that is on the panel, not
the one on the desktop. You should see a
menu list of your favorite applications.
Click on any selection in the list to start
that application.

If you want to add more favorite appli-
cations to this list, take the same steps
and add more links to the Apps folder.
The new links will automatically show up
in the QuickBrowser.

If you are good at using the mouse,
you can skip one step. You do not really
have to open the Apps folder. You can
drag any menu selection to the folder
icon. Choose the Link Here choice, the
same as if you have the folder open. The
link is added to the folder and shows up
in your QuickBrowser.

If you do not like the folder icon for
your QuickBrowser on the panel, right-
click the folder icon on the panel. Then,
select Properties from the pop-up menu.
Click on the icon button. You can choose
a new icon from the icon picker. There is
a drawer icon in my set of icons, but I do
not know if you have a drawer icon on
your computer.

You can make as many QuickBrowsers
as you want. If you want to organize your
favorite applications into different
QuickBrowsers (drawers), create a folder
for every category and drop links into the
folders according to the category. To give

an example, create an Office folder, and
drag links to your office applications into
it. Then drag the folder to the panel to
make it a QuickBrowser. Create an
Internet folder and drag Internet applica-
tion links into that folder. And so on. Easy
as pie. Speaking of pie, I bet you are glad
I did not say anything about bran muffins
and number two.

Q How do you set up special
Konqueror profiles and choose them

from a QuickBrowser menu?—Mango
Parfait

A I asked myself this question because
Harry Bump reminded me of this

trick. By an amazing coincidence, I hap-
pen to know the answer.

Right-click somewhere blank on the
KDE panel where you see icons to
launch applications. Select Add to
Panel→Special Button→Konqueror
Profiles. A new Konqueror icon will show
up on the panel. It looks like the regular
Konqueror icon, except it has a little
pointer like any QuickBrowser. Click on
the new icon. Select from the list to start
Konqueror as a Web browser, file man-
ager, a Midnight Commander-style file
manager and more.

You can stop here and enjoy this
feature. But it is even better if you

make your own custom profiles that
help you work faster.

You can decide what kind of profile
helps you. For an example, here is how
to make a profile I made that saves me
a lot of time. It lets me sort out files
that I download and put them in the
right folders.

Open a Konqueror File Manager win-
dow. Select Window→Split View
Left/Right. This makes two file manager
panels in the same window. Click on the
left panel to make it the active panel.
Select Window→Split View Top/Bottom.
Click on the right panel. Select
Window→Split View Top/Bottom. This
makes four open panels in one window.

Each panel can point to a different
directory. Click on the upper-left panel
and use the navigation buttons to make
this panel point to the folder where you
download files. Click on the upper-right
panel and change it to point to the fold-
er where you keep music files. Click on
the lower-left panel and change it to
point to the folder where you keep
movies. Click on the lower-right panel
and change it to point to the folder
where you keep pictures.

Now select Settings→Save View Profile
File Management. But do not save this
profile as File Management or it will over-
write your normal File Management pro-
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file. When the save window pops up,
change the name File Management in the
top edit field to something like Download
Mover. Check Save URLs in profile. This
means the profile will remember to open
the same folders in the same panels. I
also check Save window size in the pro-
file, because I like the window to look the
same each time. Then, click the Save but-
ton and save this new profile. This new
profile now appears in the profile
QuickBrowser list.

After you download songs, movies
and pictures, you can use the Konqueror
QuickBrowser to open the Download
Mover profile. The window with the four
panels opens up. Drag and drop the
music files from the downloads folder to
the music panel, movies to the movie
panel and so on. It is so easy.

Q I am running Mandrake and the
sound card doesn’t work right. I am

running SUSE and Konqueror doesn’t start.
I am using Mandrake/SUSE and XYZ does-
n’t work.—John Q. Public

A I am too lazy to do real statistics,
so 73% of the time I make up my

own. I say 60% of questions and com-
plaints in my inbox come from people
using Mandrake or SUSE. I do not think I

exaggerate too much. The problem is I
cannot make your sound card work from
here. I cannot make Konqueror work
from here. I cannot solve most of your
technical-support Mandrake and SUSE
problems from here.

I can give some advice. If you use
the free version of Mandrake or SUSE,
you have a choice. First choice: buy the
official version and call the company for
support. Second choice: stop using
Mandrake or SUSE, and install some-
thing else that does not give you so
many problems.

You can install Linspire, Ubuntu,
Kubuntu, Knoppix, Debian, Fedora Core
4, Mepis or others. There are many
alternatives to Mandrake and SUSE, and
most of them are free. I do not get so
many complaints about sound cards not
working and software crashing with any
of these distributions. Maybe it is
because more people use Mandrake
and SUSE than these others. Maybe.
Research companies say most people
use Red Hat. So maybe not. Why are
there so many complaints about
Mandrake and SUSE but not so many
for Red Hat?

I have recommended Mandrake 
and SUSE many times. Maybe it is time
to stop.

Q I desperately need to get my printer,
a Canon PIXMA iP4000R up and run-

ning to be able to leave my old Wintel
machine to do experimental work on tiny
Linux OS distros. Printer driver PLEASE. I
have USB 2 and RJ 45 ports on both note-
book and printer.—Brian

A If you do not have the latest version
of CUPS (Crappy UNIX Printing

System) on your system, make sure you
install it or upgrade it and start it up.

Now you can use the KDE Control
Center to add a printer. Find the Control
Center in your KDE menu, and open it.
Click on the plus sign next to the word
Peripherals. Click on Printers. Click on
Add, and then select Add Printer/Class.

If you want to use the CUPS Web
tool instead of the KDE Control Center,
open a Web browser and go to the URL:
http://127.0.0.1:631.

No matter which method you use, go
through all the obvious steps to add a
printer. Make sure you specify the USB
port you will use (USB printer #1, if this is
the only USB printer).

You will get to a step where you will
have to say which Canon printer you
want to use. You will not find your printer
anywhere on the list. Do not worry. If you
are using the KDE Control Center, you

P2P

19www.tuxmagazine.com

http://127.0.0.1:631
http://www.tuxmagazine.com


should see a printer called BJC-7004. Pick
the printer BJC-7004. It should work fine.

If you are using the Web control pro-
gram for CUPS, the printer will probably
show up in the list as Canon BJC-7004
Foomatic/bjc800 (recommended) (en).
Pick that one. It should work fine.

There are also Japanese driver 
packages made for your printer. Some
people say they give you more control
over the printer. I do not know if this 
is true, and I do not know which pack-
ages you need. What I hear is that it
will not hurt to install the packages
bjfilter860, bjfiltercom, bjfiltercups and
bjfilterpixus. At least one of these is
supposed to be useful. If you want to
try them out, you are on your own.
You can get them from this URL:
ftp://download.canon.jp/pub/driver/bj/linux.

Q Hello Mango. I just started using
Linux two months ago. Using

Mandrakelinux 10 with GNOME, I wonder
if I have to empty my temp files on a reg-
ular basis. Like, for instance, after Web
surfing. One has to do this in Windows, but
I don’t see the possibility for this in Linux
(other than cleaning up surfing history).
Won’t my computer slow down if I don’t
empty temp files every now and again?—
Ton Smits

A There are different kinds of tem-
porary files. Linux keeps many

temporary files in the directory /tmp.
You do not need to clean this yourself.
All of the popular Linux distributions
clean out the /tmp directory on a rou-
tine basis. Debian and most Debian
spin-offs (Knoppix, Ubuntu and so on)
clean up the /tmp directory when you
start up the operating system. Fedora
and some other distributions schedule
a program to clean up the /tmp direc-
tory once a day. I have Mandrake, 
but I do not like Mandrake, so I do 
not use it. But, I know Mandrake
cleans the /tmp directory with the
“schedule the cleaner to run once
daily” method.

Your browser or browsers also keep
temporary files in a cache. Do you run
Firefox? Select Edit→Preferences and
then click on Cache. This is where you
control how Firefox stores temporary
files. My Firefox uses 50 megabytes for
a cache. There is a Clear button to
empty this cache, but you do not need
to use it unless you have been naughty
and are rightfully ashamed. Don’t surf
porn. Get a real girl. We are much 
better than pictures or live Webcams.
Anyway, the cache does not slow 
down the computer, because the cache

never gets bigger than 50 megabytes.
If you do not want your browser to 
use so much disk space, make this
number smaller.

Even if you do not run Firefox, your
browser has a cache. Just find the right
menu selection and preferences screen
to set the size of the cache you want to
use or clear it. If you use the latest
Opera (8.x), select Tools→Preferences
from the menu and click on the
Advanced tab. If you use Mozilla, select
Edit→Preferences from the menu and
click on the plus sign next to Advanced.
Then click on Cache. If you use Konqueror,
select Settings→Configure Konqueror and
then click on the Cache icon.

There is another set of temporary
files you may want to clean. Linux dis-
tributions keep package files on the
disk even after you install them. Some
distributions automatically manage this
cache of packages, others don’t. You
can clean them with the Kpackage 
program if you have it. Run Kpackage
(it is in your KDE menu, somewhere
different for each distribution). Select
Cache→Clear Package Folder Cache
from the menu. Then select
Cache→Clear Package Cache. Now all
the old package files are gone.

If you use Synaptic, select
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Settings→Preferences, and then click
on the Temporary Files tab. You can tell
Synaptic to clean up after itself every
time you install packages. You can click
on the Delete Cached Package Files
button to clean up right away.

You are using Mandrake 10? I have
Mandriva Linux 10.2 Limited Edition
installed (it is the free version). As far
as I know, it is the latest version of
Mandriva, yet it includes KDE 3.3.2. I
stopped using KDE 3.3.2 when I saw
someone present it on the Antiques
Roadshow. If Mandriva upgrades KDE
from 3.3.2 to 3.4.1 before the next
KDE version comes out, I will consider
using Mandriva.

Do not write to me about cooker.
Mandriva/Mandrake has a cooker
branch with more up-to-date software.
This is like the unstable branch of soft-
ware in Debian. Here is the difference.
The unstable branch of Debian usually
works. I think Mandriva calls their
unstable branch cooker because people
who use it are likely to get burned. Last
time I updated files from cooker, I spent
more time fixing problems than using
the updated software.

I am done with my Mandriva rant.

Back to the topic. If there is an easy
point-and-click way to delete cached
package files in Mandriva/Mandrake, 
I don’t know it. Log in as root and 
run this command to clean the package
cache:

# urpmi --clean

That is the only way I know how to clean
out the package cache in Mandriva,
Mandrake, Mandolin, Mandingo, or
whatever they call it tomorrow.

Q I just installed a new 40GB hard
drive in my HP Pavilion xt375 

laptop. I had to buy a new hard drive
because the old one died. The most 
convenient one for purchase was from
CompUSA (a Sony)...the old one was 
an IBM hard drive. The problem I’m 
having is that I cannot get the laptop 
to boot into any distribution that I
install (Debian, Fedora Core 3, Mandrake
10, Symphony OS, KnoppMythTV,
Ubuntu and so on). It always can boot
from the CD and install the software,
but it hangs during reboot at the 
GRUB prompt or the LILO prompt.
—Tony Freeman

A It is too hard to solve this problem
without more information. My

advice is to enter the BIOS setup
(CMOS setup) when you boot your 
laptop. Look at how the BIOS detects
your new hard drive. You may need 
to change some of these settings.
Experiment. If the BIOS has a special
option to “discover” the drive, try 
that. To give another example, the 
BIOS may let you turn on and off
something called LBA. If it is on, try
turning it off. If it is off, try turning it
on. It is possible that your BIOS is too
old to work with this new drive. If you
can update the BIOS try it. Does it
sound like I am guessing that your
problem has to do with the BIOS? You
are right. That is my guess. I hope I
guessed right.�

I am a sweet, humble, delicate and very cute
genius who is at your service to answer your
Linux questions. Send your questions to
mango@tuxmagazine.com. I am deeply sorry 
that I do not have time to respond to anyone
directly by e-mail, but I will select as many 
questions as I can and answer them here.
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So, you know what cells are, and you might even be familiar with a specific
spreadsheet application that you’ve used in the past. This month’s article
shows you how to start using OpenOffice.org Calc to produce spreadsheets
that use charts and formulas. The article is broken up into sections, so that if
you’re not interested in one of the two topics, you can read only what
applies to you.

CHARTS
Charts are commonly used during presentations, reports and in many other
areas of life. Charts allow you to represent graphically two sets of numbers
that relate to each other. In simple terms, I’m talking about bar charts, pie
charts and scatter plots. This is not all that OpenOffice.org can do in this
area, but that’s what we’re going to focus on for now. Good examples of
data that work well for charts are temperature over time, gas prices over
time and mathematical functions. With a little work, they even become
effective and beautiful at the same time.

To get started with a chart, the first thing you need is the data that’s going
to be represented in the chart. I’m going to start with the spreadsheet we used
in our last article, which is shown in Figure 1. If you are reasonably familiar
with spreadsheets, you can reproduce this basic data even if you didn’t read
last month’s article and save your work. If you need help, follow the instruc-
tions from last month’s article, save your work and return to this tutorial.

Now, we’ve already labeled some of our data, which will come in handy
quite shortly. Here is the goal. You will make a chart that looks like Figure 2
with this data. This is a bar graph that shows the earnings for each depart-
ment per quarter.

To start, we need to select our data and labels. This is actually a relatively
picky process, because everything we select, Calc will place into the chart.
Because of this, we want to select the cells as shown in Figure 3 to include
only the necessary data.

If you don’t have labels on the data, it’s fine to select only the numbers, but

in most cases, they’re already there anyway, so you might as well save yourself
the work of retyping them. If you’re more familiar with math terms, it’s good
to know that most spreadsheet applications, including OpenOffice.org Calc,
assume that if you’re plotting two sets of data against each other, the list on
the left is the x axis, which refers to the horizontal axis.

Select Insert→Chart, and you are presented with the dialog box shown in
Figure 4.

What we’re concerned about on this screen is ensuring that our chart
gets placed on a different sheet (a page in our multipage spreadsheet) than
the one we’re using for the data. The default is to put the chart on the sheet
you’re currently using. I prefer to have the chart on a separate sheet. You

HHooww  ttoo  UUssee  tthhee  OOppeennOOffffiiccee..oorrgg  CCaallcc  SSpprreeaaddsshheeeett,,  PPaarrtt  IIII
Kevin explores OpenOffice.org Calc in greater depth in this follow-up article to last month’s introduction to spreadsheets.
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might want the chart on the same sheet as the data if you want to watch
how the chart changes as you modify your data, but for now we’ll do it my
way. For this example, drop down the list labeled Chart Results in
Worksheet and select Sheet2. Ensure that you check the box labeled First
column as label, because the first column in the selection is going to be the
labels for the data along the x axis. Click Next.

The next screen you see lets you choose what type of chart you’d like.
You also get to see a rough view of what that type of chart would look like
with the data you’ve provided on the section to the left. Select the bar chart
and click next.

Now you are asked more specifically what type of chart you’d like to create.
We don’t need to change any of the settings, so click Next. Now you need to
enter a chart title. Enter the title we had on our previous spreadsheet (Quarterly
Earnings 2005) and click Create. Figure 5 shows this process.

Once you’ve clicked the Create button, Calc goes to work and creates
the chart shown in Figure 6. We want it to appear larger, so use the mouse
to click on the bottom-right corner of the chart and drag it down and to
the right until you’re happy with the proportions. You also may want to
move the chart around a touch on the sheet until you’re happy with where
it is. Simply move the mouse to the border of the chart. When you see a
cross with arrows pointing up, down, left and right, click the mouse and
drag the chart to the location you like best. If you make any mistakes, don’t
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be afraid to use the Edit→Undo command. You also can hold down the Ctrl
key and press Z (Ctrl-Z), the keyboard shortcut for undo.

At this point, we need to improve the labels for the rows and columns. You
can do this when you first create the chart, but it is easier to experiment if you
make these tweaks afterwards. Click on the border of the chart in order to
select it. Then click on Insert→Title and you should be presented with the dialog
shown in Figure 7. It is important to click on the border to select the chart first,
otherwise the option to insert a title will not appear in the menu.

Check the boxes next to the X and Y axis titles, and type Quarter and
Euros (Thousands) respectively. Click OK, and you’ll see your new axis titles.
At this point, you can change the font styling on any font in the chart by
looking at the options under the Format or right-click menus. Feel free to
stylize your charts to ensure they look professional and attractive.

Also, a side note here is that you can rename and delete sheets in the
workbook you’re working on by right-clicking on the sheet tabs. You can use
the pop-up menu to remove Sheet3 entirely, since we are not using it. You
can use the pop-up menu to name Sheet1 Report, and Sheet2 Chart.

FORMULAS
Formulas are the most powerful feature of any spreadsheet application.
They allow you to perform simple or complex calculations on numbers in
the spreadsheet. The results appear in the cell where you entered the
formula. You can then create another formula that uses the result as
part of its calculation—and so on. If you change any data that affects
the first formula, the spreadsheet recalculates everything so that all the
results reflect your changes.
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This makes a spreadsheet a powerful tool
for asking, “what if?” Change data here or
there, and the entire spreadsheet recalculates
the affected cells, redraws affected charts and
updates the information it’s showing, allowing
you to try out various hypothetical situations.

Let’s start this exercise with the spreadsheet
from the previous article, shown earlier in
Figure 1.

There are different ways to enter formulas.
First, you can simply enter them with the key-
board. Whenever you type an equal sign (=) as
the first character in a cell, this tells the spread-
sheet that what you are about to enter is a formu-
la. For instance, to make cell A1 show what you
get when you add the contents of cell C6 to the
contents of cell C7, enter =C6+C7 into cell A1. The
plus and minus signs are obvious mathematical
operators. If you are not used to spreadsheets,
note that you need to use the asterisk (*) to mul-
tiply and the slash (/) to divide. For example,
=C6*C7 multiplies the contents of C6 by the con-
tents of C7, and =C6/C7 divides the contents of
C6 by the contents of C7.

There are many built-in functions to make
your life easier. For example, you don’t have to
type =(C5+C6+C7+C8) to add the contents of
these four cells. You can use a function called
SUM to add all the cells in a range. You can
type =SUM(C5:C8), which gives you the same
result as =(C5+C6+C7+C8).

If you want to explore the various functions,
use the OpenOffice.org Help feature and look up
Mathematical Functions.

Now, let’s use a few functions to add useful
data to our spreadsheet. To see just how much
money the company made for the entire year,
click on cell C13 and enter the label Grand Total:.

In the cell below it (cell C14), type =SUM(C5:G8)
and then press Enter. Calc just summed up the
entire table for us.

Now, let’s see how much each department
made for the year. Go ahead and label row 9 as
Total: for the chart (enter the text Total: in cell B9).
We’ll start with Accounting. In cell C9, enter
=SUM(C5:C8) and press Enter. The column is now
summed up.

It would be a lot of work if you had to enter
a similar formula for every column. You don’t
have to do that. Calc has a very useful feature
that allows you to extend your formulas to apply
to other rows and columns. Click on cell C9.
Notice the little box at the bottom-right corner
of the cell? When you point to that box, the
mouse cursor changes. Click and drag that small
box to the right, until you have selected all the
cells from C9 to G9.

You also can use this fill function to create lists
of numbers by typing the first number of the list
and then filling in as far as you need. For exam-
ple, you could type the number 1 in a cell, then
click and drag the little box to highlight a range of
cells. Calc will fill the rest of the cells with an
incremental series of numbers starting with 1,
then 2, then 3 and so on. Calc is even smarter
than that. Type January or even the abbreviation
Jan into a cell. Click on the rectangle and select a
range of cells. Calc fills that range with labels for
the following months.

There is a way to enter formulas that is easier
from time to time. Whenever you need to specify a
certain cell while you’re entering a formula, you sim-
ply can click on the cell you need or use your arrow
keys to move to it. Once the cell you’re looking for
is in the formula where it needs to be, simply con-
tinue typing your formula. You also can drag to

form ranges like what SUM is looking for. For exam-
ple, go back to cell C9. Type =SUM( and stop there.
Now click on cell C5, hold down the mouse button
and drag the selection until you have selected cells
C5 through C8. Notice that Calc filled in part of the
SUM formula for you. Finish the formula by typing
the final parenthesis ), and press enter.

Finally, let’s use another function to figure
out what the average per-quarter income was
of each department. Click on cell C10 and enter
=AVERAGE(C5:C8). Use the fill technique to fill it
across the columns. Now that we know what
each department averages, we can figure out
what the average income per department for the
year was. In a cell that’s out of the way, such as
E14 in the example, enter =AVERAGE(C10:G10).
This is the average of the average that each
department took in. If you’re feeling a little wish-
ful, and you think to yourself, “It would have been
really nice if the Marketing department had gotten
the TUX Magazine account during the second
quarter. They would have made at least 10,000
more Euros that quarter. I wonder what the num-
bers would look like then?” You can simply modify
the number you need, press Enter or navigate
away from the cell, and all the cells that refer to
that will update to reflect the new information.

At this point, you should be ready to create
some pretty impressive spreadsheets, complete with
graphs and charts to help you visualize the data.�
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Does the name Guarddog bring an image to mind? A brown leather collar
with spikes around the neck of a large, muscled, snarling canine? Perhaps
we need to reduce your anxiety about having a guard dog. This one won’t
eat you out of house and home, and it won’t be aggressive with the neigh-
bors. It will sit when you tell it to and will roll over only on your command.
What we are talking about here is a guard dog for your computer.

Firewalls are now installed on just about every computer, and for good
reason. The Internet is not a safe place to go barefoot. It hasn’t been for a
long time. Geeks have been making firewalls for years. Really geeky firewalls.
Firewalls that almost nobody understands. A question often asked is, “How
well can a firewall protect me if I don’t understand how it works?” Probably
not as much as it could if you had better control of it.

In mid-2000, Simon Edwards put the first version of his firewall configura-
tion tool, Guarddog, on the Internet for everyone to use. Since that time,
Simon has released a new version once or twice a month. This series of
improvements has culminated with his most recent stable release, the
December 16, 2004 2.4.0 version.

I wrote to Simon to get a little background on why he started the project.
Here’s his response:

I’ve had a strong interest in usability and GUI design for a long time, and
about the time that Guarddog started, I was also very interested in comput-
er security. What I learned from computer security is that many security
problems are simply caused by errors in the configuration of the software by
the user, what people might refer to as a “human error”.

Another important principle in computer security, this time directed more
toward the design of network firewalls in particular, is whitelisting. This idea
is simply, “Better to block everything and allow what is known to be good
through, instead of the other way around, for example, filtering with a
blacklist.”

Looking at the firewall programs and scripts available for Linux at the time, I
saw that for securing a small network, all available programs failed one or
both principles.

So that is how Guarddog started. It is my attempt to create a really paranoid
firewall that also tackles the difficult configuration error problem with good
user-interface design. Guarddog was designed starting from the point of
view of the user, and not from the underlying network filtering system. This
is why Guarddog is so different, and easier to use than every other firewall
program or script on Linux.

Simon has done a great job of removing the complexity of configuring a
firewall. Instead of using an editor to make changes to a cryptic looking text
file that the firewall uses, you use a graphical interface and you tell it what
tasks you want to accomplish. The Guarddog Project motto is: “Protecting
your computer with a cute little dog”.

INSTALLATION
If you are running a Linux distribution that has a package management sys-
tem, your first stop should be to find out if your distribution already has
Guarddog installed, or a Guarddog package on the CD or in an Internet
repository ready for you to install. If you can install Guarddog that way, you
will save time. If this is the case, you can use that install method and jump
directly to the Planning section of this article.

If your distribution doesn’t support a Guarddog install, you can download
an installation file for several distributions at http://www.simonzone.com/
software/guarddog/#download.

FOR GEEK EYES ONLY
And, of course, the ultimate installation file is there as well, the tarball. The tarball
file has been a longtime method of distribution of source code that is packaged in

GGuuaarrddddoogg  FFiirreewwaallll  CCoonnffiigguurraattiioonn
Your very own guard dog against malicious crackers and “script kiddies”.

PHIL BARNETT
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a way to be installed on many different platforms. Installing a tarball is a five-step
process. Download, uncompress, configure, compile and install.

If you didn’t find an install by one of the two easier methods above, then
you’ll have to download and install the tarball file. As I write this article, the
name of the current tarball file is http://www.simonzone.com/software/
guarddog/guarddog-2.4.0.tar.gz.

You need to be logged in as root to install this kind of system utility. In my
last article [July 2005], I talked about logging in only as a regular user most of
the time. This is one of those times that you need to be a system administrator
to perform the install. To become the system administrator, open a command
shell and run the Switch User command (note the hyphen):

su -

After you enter this command, you’ll be asked for the root password.
Enter it correctly, and you are now the system administrator and you’ll be in
the /root directory. Most systems change the prompt from $ to # when you
are logged in as the system administrator.

Almost all systems now have the wget command available, and it’s a
great way to grab a file. So, here’s the command (you’ll need to correct it if a
new version is available):

wget http://www.simonzone.com/software/guarddog/guarddog-2.4.0.tar.gz

This command fetches the file and brings it to your local directory. If you
don’t have wget, be creative. There are dozens of ways to fetch a file. Use
one of them.

Next in the process is to uncompress the tarball:

tar -xzvf guarddog-2.4.0.tar.gz

This will uncompress the files into their original layout as the author creat-
ed them. In this case, the author put his files into a directory, so we need to
move into it to continue:

cd guarddog-2.4.0

Once this is done, the next step is to run a script that determines how

your machine is set up and configures Guarddog to be ready to compile on
your machine. This is typical of the tarball compiling process. Run it now:

./configure

When the script completes, you are ready to compile. If the script stopped
early, it will tell you what is missing from your system. Generally, you go get
the missing package and try again. Most systems will have everything need-
ed. After you have successfully run the configure script, it’s time to compile
Guarddog. So, do it:

make

Now, that wasn’t too hard was it? Your computer compiles all of the
Guarddog source code. The amount of time this process takes depends on
how powerful your computer is. It took about a minute on my Athlon XP
2500+. You’ve just compiled a tarball, but it’s not installed yet. The final step
is to run the installer. In a tarball, the installer is generally part of the make
process. You add a parameter and the files get installed to their final destina-
tion. In this case, the command is:

make install

And you are done! You can type:

which guarddog

to see where it is installed. The default installation is /usr/bin/guarddog. You
are done with the system administration part of this install, so it’s time to exit
from your root login by running the exit command now:

exit

If you installed from a tarball, you will need to create an icon to run Guarddog.
In KDE, right-click the desktop and select Create New→File→Link to Application.
This pops up the application link wizard.

You need to fill in four things here to make the icon work properly. First,
you need a caption for the icon. Replace the words Link to Application with
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Guarddog. To the left of that, you will see a Blue
Gear. When you click on it, a screen opens that
allows you to select a new icon (Figure 1). More
than a hundred icons are available here, or you
can download an icon from the Internet and link
it in here. Look and you’ll find the one named
Guarddog. If it’s not there, your installation may
have put one on the disk somewhere. I did find
one in the System icon files, but when I looked
around, I also found a copy of the Guarddog icon
that the installer put in /usr/share/icons/hicolor/
32x32/apps/guarddog.png. If you didn’t find one
from your install, you can select any icon.

Next, click on the application tab and put
/usr/bin/guarddog in the command field (Figure 2).

Because this tool needs to run as root, you
need to tell the icon to ask you for the root pass-
word and to run it as root. To accomplish this,

click on the Advanced Options button (Figure 3).
Mark the box for Run as a different user and fill in
the user name root.

Select Ok to save the icon configuration.

BACK TO THE NON-GEEKS: PLANNING
Remember what Simon said about whitelisting?
Guarddog is designed so that nothing can access
into or from the network unless you specify it.
Guarddog assumes you will be implementing a
default block all policy.

With that in mind, we should make a small list
of the things we expect to do with our computer.

From my computer, I browse Web pages, do
on-line banking, send and receive electronic
mail, send and receive files using FTP, use VNC
to view other computer screens, use secure shell
and set the time on my computer. Your list will

be different, and that is not a problem for
Guarddog. That list can be translated directly to
the services I want to allow to operate from my
machine to the Internet (listed in the order as
mentioned above): http, https, pop3, smtp, ftp,
vnc, ssh and ntp.

We need to tell Guarddog that it’s okay to do
those things from our computer.

How about the things I want to be able to
access on my computer from the outside
world? I have a Web server I would like to be
able to see from browsers at client locations. I
would like to be able to access my computer
via secure shell. These translate to the follow-
ing services I want to allow in from the
Internet: http and ssh.

We need to tell Guarddog that it’s okay to do
those two things from the Internet.
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CONFIGURATION
Now that you have your planning done, you’ll need to configure Guarddog
for your plan. Let’s start up Guarddog by clicking the icon you built earlier. If
you set up the icon properly, it will ask you for the root password. Enter the
root password and press Enter.

Guarddog should start up. If you have never started your firewall before,
Guarddog will ask you if you want to start it now. Go ahead and start the
firewall. If you want to shut the firewall off at any time, it’s easy in one of
the Guarddog configuration screens.

When you start Guarddog for the first time, you will see the default zones
in the Zone tab. The Internet and the Local zones are the only zones we will
use in our configuration (Figure 4).

The real action happens on the Protocol tab (Figure 5). When you select
the Protocol tab, you will see the two zones in the Defined Network Zones
box. Select the Internet Zone. To the right, you will see a window labeled
Zone Properties. This is a tree view of all of the protocols and software that

you can teach Guarddog to allow you to use on the Internet.
In Figure 5, you can see how I have checked the http and https services.

This allows my machine to reach Web and on-line banking pages.
You need to scan through the different protocols and software packages

represented in Guarddog and check the boxes that you want your machine
to have access to. When you get to mail, if you are not sure, check them all.
Once you get mail working, you can uncheck things one at a time until you
get to a minimum that it takes to get it working.

After you have checked all of the protocols that you want to allow out to the
Internet, you need to select the protocols you want to allow in from the Internet.
Many of you will not do anything in this step, but in our scenario above, we are
going to allow http and ssh protocols to access our machine from the Internet.
First, select the Local zone. Then, in the protocol window, select http and ssh
(Figure 6). You will find http under File Transfer and ssh under Interactive Session.

Guarddog also allows you to control how you log blocked and rejected pack-
ets. If you select the Logging tab, you will see that you can adjust these and

other options in
Guarddog (Figure
7). The defaults
seem quite sane,
and I found no
need to change any
of them, but you
may want to experi-
ment with the way
logging occurs. If
you intend to
ignore the logs, you
can turn them off
entirely. In Linux,
these logs are rotat-
ed and compressed
weekly, so it’s not a
big deal if you leave
them on. You may
need them to pros-
ecute an attempted
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break-in. Personally, I have better things
to do.

I did tell you that there’s an easy
way to turn the firewall on and off in
Guarddog, so let’s discover that and our
tour is over. On the Advanced tab, you
will see a selection for Disable Firewall
(Figure 8). If you check that box and
confirm with OK, your firewall is off.

GETTING HELP
On every Guarddog screen, there is
a Help button in the lower-left cor-
ner. This leads to The Guarddog
Handbook, which contains exten-
sive help, concepts and tutorials. If
you are having problems or feel
you need help, be sure to read the

excellent help files and
perform the tutorials.

There is a support mail-
ing list for Guarddog you
can join if you have ques-
tions about installation or
configuration. I have found
that asking questions
directly into support groups
for the programs I am
using gets me quick and
accurate answers. If you do
this, make sure to describe
your installation in detail,
like what distribution you
are using and how you
installed as well as what
problem you are having.

The more details you include in your requests for
help, the better the answers you get will be.

You can access the Guarddog support list at
https://lists.sourceforge.net/lists/listinfo/guarddog-user.

There are many advanced features in
Guarddog, but what I’ve shown you will get
you on your way. It’s a great program that lets
you have total control over your personal fire-
wall without having to invest years in the study
of firewalls and security.�

Phil Barnett is a Senior Programmer-Analyst at Walt 
Disney World where he has spent the last ten years 
working with corporate software and computer security
projects. Six years ago, he helped incorporate the popular
Florida Linux User Group, Linux Enthusiasts and
Professionals, which he considers his greatest Linux 
accomplishment (http://www.leap-cf.org). Besides 
Linux and computers in general, his other hobbies 
include woodworking and amateur radio communications.
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The Internet facilitates communication and allows
us all to share our ideas. Individual users need not
be passive spectators on the Web. Participation is
no longer limited to those with technical expertise
or the ability to afford costly, proprietary Web
development software. With Linux and open-
source software, anybody can make a Web site.

Do you want to share your digital photos with
friends and family or make a Web site dedicated
to expounding the virtues of your favorite Linux
distribution? Or perhaps you already have some
experience with Web design and you are looking
for a quality open-source alternative to replace
your favorite commercial Web development envi-
ronment? Quanta may be the application you
need to get the job done.

Quanta is a versatile Web development environ-
ment with a flexible interface and many compelling
features. A terrific tool for the Linux learner or the
ambitious adept, Quanta will scale to accommo-
date virtually any project. Unlike many commercial
Web development environments, Quanta empha-
sizes HTML entry rather than visual manipulation of
page elements. Although this unconventional
approach may make Quanta seem intimidating and
counter-intuitive, many professional and amateur
Web designers appreciate the advantages of this
innovative model. Quanta introduces a number of
unique development idioms that empower users
and contribute to quality design.

In this article, I show you how to
produce your very own Web site with
Quanta. Basic familiarity with the
structure of HTML will give you an
advantage, but it isn’t particularly nec-
essary if you keep a close eye on the
screenshots. If you have trouble fol-
lowing along, you might want to
spend a couple of minutes glancing
through the first few pages of the
W3Schools HTML introduction
(http://www.w3schools.com/html).
Don’t worry; this isn’t going to be
difficult, and there won’t be a test 
at the end.

Quanta is considered to be part of
KDE, so many modern KDE-based dis-
tributions install Quanta for you (you
might see it listed as Quanta Plus, but
it is the same program). Some distribu-
tions do not install it for you because
it is a developer tool, and the distribu-
tion assumes you are a desktop user
not a developer. The latest version of
KDE generally calls the package
kdewebdev, so that is what you want
to install to use the latest version of Quanta.
Some older versions of KDE (and some distribu-
tions) still call the package quanta, or some vari-
ant of that name. You can run Kpackage and

search for webdev or quanta, and I am sure you
will find the package you need if you don’t have it
installed already.

IInnttrroodduuccttiioonn  ttoo  QQuuaannttaa
A comprehensive guide to getting started with Quanta to create Web pages.

RYAN PAUL

Figure 1. Quanta Interface

http://www.w3schools.com/html
http://www.tuxmagazine.com


THE INTERFACE
The Quanta interface (Figure 1) contains toolbars,
sidebars, the document view and the tag palette.
It is highly customizable, so complete coverage is
well beyond the scope of this article.

The blank space in the middle of the window
is the document view, where the active file is visi-
ble. If you are working on more than one page at
a time, you can use the tabs at the bottom of the
document view to switch between open files. To
close a file, click the icon on the tab.

The tag palette is the tabbed toolbar that
appears right above the document view. Each tab
contains various buttons that either insert HTML
content into the document directly or first prompt
the user for information and then insert generated
HTML. All of the items on the tag palette also
appear in the Tags menu.

By default, Quanta uses the KDE IDEAL mode
interface for sidebars. In IDEAL mode, the but-
tons in the vertical bars on the left and right
sides of the window open various sidebar panes
that expose different kinds of program function-
ality. Sidebars obscure document content and
disappear when you click inside the document
view. Each sidebar pane has three small icons in
the top-right corner. If you click the first icon,
which looks like a diagonal arrow, the sidebar
detaches from the interface and appears in a
separate window. If you click the second icon,
which looks like a square, the sidebar becomes
sticky and embeds itself in the main window
next to the document view rather than on top
of it. When a sidebar is in sticky mode, it does
not close when you click in the document view.
The third button, which looks like an X, closes
the sidebar. In IDEAL mode, you can have only
one sidebar open on each side at any given

time. To move a sidebar,
drag the stippled bar that
runs along the top of the
sidebar pane.

STARTING A NEW PROJECT
Project management is one of
Quanta’s many strengths. You
can allow Quanta to help you
manage your project or you
can eschew assistance and edit
individual pages without an
actual project. To start the New
Project Wizard, select New
Project from the Project menu.

On the first page of the
New Project Wizard (Figure
2), enter the name of your
project and set the main
directory field to the direc-
tory in which you would like
to store your Web site. After
you have set the project
name and main directory,
click the Next button to move to the next step.
On the second page of the New Project Wizard,
you can select files to add to the project.
Because we are starting a Web site from
scratch, you should just ignore it and click Next
to move to the third page, where you can
optionally set the Author field to your name
and the Email field to your e-mail address. DTDs
are used to validate HTML content, so the DTD
you specify determines the version or dialect of
HTML that your site uses. In this tutorial, we
use HTML 4.01 Transitional. Now, click Finish to
generate the project.

CREATING A NEW PAGE
To create a new page, select New from the File
menu or click the New toolbar button. Then, click
the first button on the Standard tab of the tag
palette to open the Quick Start dialog (Figure 3)
where you will type the title of your new page in
the Title text field and make sure that the Style
area check box is selected before you click Ok. The
Quick Start dialog inserts HTML for a default,
blank Web page into your empty document. Select
Save from the File menu or click the Save toolbar
button to save the page. Now give it a filename,
click the Save button in the save dialog and then
click Yes to add the new page to your project.
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ADDING CONTENT
Now it’s time to add some content! Click on the
line below the opening <body> tag. When you
click inside of the document view, it places the
text insertion point (TIP) at the position you have
clicked. Now, select the Style tab of the tag palette
and click the H1 button to insert a large page
heading. Each H button inserts a heading of a spe-
cific size. The higher numbers indicate smaller
headings. When you click the H1 button, Quanta
inserts an <h1> tag in your document and places
the TIP inside of it (Figure 4). Now type in your
page title. You have added a heading to your page!

Let’s see how it will look in a Web browser. To

enter preview mode, click the
toolbar button that looks like
an eye, or select Preview from
the View menu. You should
see your page heading in large
bold type. To get back to edit
mode, click the toolbar button
that looks like a window with
text in it or select Source Editor
from the View menu.

Now, let’s add some text
below the heading. Start by
making a couple of empty lines
after the line with the heading
tag. To insert a paragraph tag,
select the Standard tab, and
click the button with a P in it.
Quanta adds a <p> tag to your
document and places the TIP
inside of it (Figure 5). Paragraph
tags are used for blocks of text.

Type a few sentences, and
then click the preview button to
see how it looks (Figure 6).

Let’s try something a bit
more interesting. How about a
table? Add a few extra blank
lines after the end of the clos-
ing <p> tag, and click the first
button on the Tables tab of
the tag palette to start the
Table Editor (Figure 7).

You can use the Rows and
Columns input boxes to
change the number of rows
and columns in your table. Set
both to three and observe the
Table Editor’s behavior. You
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now have an inter-
face that vaguely
resembles a spread-
sheet. Click one of
the cells, type in a
value and then click
the Enter key to
move to the next
cell. You also can
use the arrow keys
to navigate
between cells, and
you can use the
actions listed on the
right-click context
menu to add and
remove rows and
columns at a specific point in the table. When you finish adding data,
click the Ok button to add the table to your page. If you want to alter
the table, place the TIP anywhere inside the table HTML tag, and click the
Table Editor button on the tag palette.

I’m sure that many of you would love to know more about the HTML
that Quanta adds to your document. You are in luck, because Quanta has
an excellent context-sensitive help system. You can right-click anywhere
inside of any tag, and select Context Help from the menu to view the
WDG documentation associated with the tag.

ADDING STYLE
What do you think of your page so far? It looks a little dull to me. Let’s
snazz it up a bit and give it some style! Place the TIP anywhere inside the
<p> tag, and click the CSS button on the Style tab to launch the
Cascading Style Sheet (CSS) editor. Quanta’s CSS editor provides a power-
ful and effective mechanism for page styling. The left side of the CSS edi-
tor contains the CSS property tree, which lists the individual style proper-
ties associated with the current tag. The right side contains the CSS pre-
view pane and the content pane. To start with, let’s change the para-
graph background (Figure 8). Click the plus next to the background item
in the CSS property tree, and then click the background-color property. A
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color input text box appears above
the preview pane. Click the button
to the right of the text box to open
the color-selection dialog. Pick a
nice color for your paragraph back-
ground and then click Ok. The pre-
view pane should instantly reflect
the style change. You also should
see a check in the check box next
to the background-color item in
the CSS property tree. If you want
to remove the background color,
you can just uncheck the back-
ground-color item.

Now, let’s add an outline
(Figure 9). Click the plus next to
the outline item in the CSS prop-
erty tree, and then click the out-
line-style item. The drop-down
menu above the preview pane
lists all the available outline
styles. Try them all and see if you
can find one that you like. To
change the color of the outline,
select the outline-color item in
the CSS property tree and use
the color selection dialog. You
can change the outline-width
property to set the size of the border.

When you are satisfied with your style
changes, click Ok to close the CSS editor.
Quanta adds a style attribute to the current
tag to implement your style change.

It is also possible to establish a universal
page style for a specific kind of tag.
Remember when I had you click the Style
area check box during page creation? You
can use the <style> tag inside of the <head>

tag to add styles that affect the entire page.
Place the TIP inside of the <style> tag and
click the CSS button in the Style tab of the
tag pallete. When you are inside the <style>
tag, Quanta displays the CSS selector dialog
instead of the CSS editor (Figure 10). Let’s
add a default style for H1 headings. Select h1
from the Add Selector drop-down list and
then click Add. The selector dialog adds the
h1 tag to the selector table.
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Double-click the h1 item in the selector table to start the CSS editor.
Change the color property and then click Ok in the CSS editor and the
selector dialog. Switch to preview mode and take a look. Now all the
<h1> tags on your page will automatically inherit the style established in
the <style> tag. To remove the style, go back to the selector dialog, select
the h1 item in the selector table, and then click the Selected button in the
Remove Selector space.

Some tags have special style attributes that cannot be modified with the
CSS editor. To add a border to all the cells of a table, you have to click the
Table Properties button in the Table Editor and then set the Border value to
the width (in pixels) that you want the border to be.

There are many useful CSS features that I have not covered here. CSS is
immensely powerful, and true mastery of the art can take quite a bit of
time. I learned CSS primarily by example. There are many Web sites with
excellent tutorials that will show you how to use div tags and CSS to achieve
a wide variety of elegant page themes.

ADDING FILES TO A PROJECT
What would a Web site be without pictures? To include images and
other files in your Web site, you must import them into your project
and allow Quanta to copy them into your project directory structure.
First, we add an images directory to our current project. Click the 
sidebar button with the cubes to open the project management 
sidebar. Next, right-click the project item (the first item in the project
management tree) and select Folder from the Create New submenu.
Quanta asks you to name the new folder. Type in images and click Ok.
You should now see your new images directory listed in the project
management sidebar.

Now, let’s put an image in our new images directory (Figure 11).
Select Insert Files from the Project menu and Quanta will present you
with the familiar KDE file selection dialog. After you select the files you
want to add and click the Open button, Quanta asks you to select
which project directory it should copy the files to. Click the button to
the right of the location text box, select the images directory and then
click Ok in both dialogs.

Quanta has now copied the file into your project. Now, you have to
tell it to update the project management sidebar. Right-click the project
item and select Rescan Project Folder from the context menu. Next, click
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All and then Ok in the dialog that appears. Now, if you click the 
plus next to the images directory in the project management sidebar
you should see that it contains the image you have added. To include
the image in your Web site, drag it from the project management
sidebar into the document view and drop it in the document where
you want it to appear. Try dropping it into the line above your first
<p> tag. When you drop an image into your HTML document, 
Quanta automatically inserts the necessary <img> tag with all the 
correct attributes (Figure 12).

ADDING LINKS
Links are easy to add. Use the procedure presented in the Creating
a New Page section to make a second page. Now, use the tabs at
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the bottom of the document view to switch back to the
first page. You should see both pages listed in the project
sidebar with the other project files. Drag the second page
from the sidebar into an empty line in the document.
Quanta inserts an <a> tag and places the TIP inside of it
(Figure 13). Type in the text that you want to link to the
second page and click the preview button to see what it
looks like (Figure 14).

Now, let’s add a link to an external Web site. This time,
we will place it in a paragraph of text. Add a few empty
lines and then create a <p> tag using the tag palette. Type in
a sentence or two and then click the button that looks like
an anchor on the standard tab of the tag palette to open the
link creation dialog.

In the HREF textbox, type (or copy and paste from your
Web browser) the URL of the Web site you want to link to and
then click Ok (Figure 15). Quanta inserts the link and places
the TIP inside of the <a> tag. Type in the text that you would
like to link to the URL, and then use the arrow keys or the 
cursor to move the TIP to the end of the closing </a> tag,
where you can continue to type your paragraph (Figure 16).

EPILOGUE
We have now constructed an entire Web page in HTML 
without having to type in a single tag. I hope this article 
has helped you understand the power and flexibility of
Quanta and its unique design paradigm. There are many 
features I could not cover here, and I urge you to continue
exploring its capabilities on your own. Don’t be afraid to
experiment with buttons on the tag palette and use the 
context help to learn more about the tags. If you make a
mistake, you always can use the Undo feature. Use the 
preview mode often; it will help you visualize your page 
and better understand the implications of various tags 
and attributes. For downloads and more information, visit
the Quanta Web site (http://quanta.kdewebdev.org). I look
forward to your comments and questions. Don’t hesitate 
to send me an e-mail!�
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Figure 15. Link Creation Dialog

Figure 16. Placing a Link in a Paragraph
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If your home computer situation is anything like
mine, not everyone in your household has jumped
in as an open systems convert. There may be sev-
eral reasons for this; however, the three that I
heard most often when I tried to convert my fami-
ly were “but I can’t play Battle Zone 3000 like
Suzi”, “Why can’t I play this movie trailer off
msn.com?” and, of course, “I’m not going to
have to learn something new, am I?”

Whether these concerns are justifiable is for
the most part irrelevant, because ultimately, even
if you try to take the intellectual high ground, the
whine factor becomes intolerable and you end up
beating a hasty retreat, tail tucked and offering up
a plethora of apologies for ever suggesting some-
thing so blatantly insensitive.

And now, your spouse and children have laid
claim to your best PC and printer (generously con-
ceded to assist you out of that hole you dug). You
labor away in your dungeon—I mean basement
office—on that old laptop with too little disk
space and the dot-matrix that saw you through
college. Even if this isn’t your particular predica-
ment, you should be thankful that Andrew Tridgell
created Samba in 1992 for the sole purpose of
helping you out of this particular jam. (Well, per-
haps it wasn’t his sole purpose; I tend to get a lit-
tle carried away working alone down here. But I

am sure it was one of the top five motivators.)
Through Andrew’s help, you can now take advan-
tage of the wealth of space residing on your kid’s
PC and use your spouse’s color laser printer. Just
to be fair, I should mention that there are a lot of
sung and unsung heroes who helped create and
improve Samba, such as Jeremy Allison, John
Terpstra and too many more to name here.

So what is Samba? Assuming you know that it
is not a Brazilian ballroom dance, Samba is a pro-
gram that allows non-Windows PCs and servers to
communicate with PCs and servers running
Microsoft operating systems. The name is loosely
connected to the fact that Microsoft uses what is
called the SMB (server message block) protocol to
share things. These days, SMB runs on top of
TCP/IP to provide near seamless integration with
Windows-based computers and their peripherals,
and like the rest of the industry, it too has evolved
over the years.

From the early days until the not too distant
past, it was hard to configure Samba on Linux.
You had to use your favorite text editor and
adventure into the mysteries of the smb.conf
file—not an especially hazardous journey but, at
the same time, not for the technically squeamish
either. However, now it has become so easy to
implement Samba on Linux that several Linux dis-

tributions, like Linspire and Ubuntu, integrate
Samba into their installation process, giving you
immediate access to all your Windows shares with

DDaanncciinngg  wwiitthh  WWiinnddoowwss
Various ways to access Windows files and printers from your Linux desktop.

ALLEN MERCER

Figure 1. Windows has something to share.

http://www.tuxmagazine.com


the same trivial effort that a browser lets you
access the Web.

THE WINDOWS SIDE
Of course, a prerequisite for having Windows
resources available on your LAN is that your
Windows system has something to share. Just
because a Windows PC exists on your network
does not, by itself, give you access to all of its
resources. Each resource you want to have
available must be configured so it can be
accessed by other network clients, whether or
not they are Windows-based. This can be
accomplished relatively easily by going to My
Computer (from your start menu or desktop,
depending which version of Windows you are
running) and using its explorer to locate or cre-
ate a folder you want to share with other com-
puters on your LAN. Right-click on the folder
you want to share and select the Sharing and
Security option. Once in the Shared Document
Properties Dialog box, check the Share this folder
box and provide a Share Name, linuxshare, 
for example (Figure 1).

Next, configure a printer by going to your
Control Panel (also available from the Start
Menu), clicking on the Access the Printers 
and Other Hardware option, and then View
your installed printers or fax printers. Right-
click on the printer you want to share on your
network to bring up the Properties menu, and
then click on the Sharing menu item. Indicate
your desire to share this printer by clicking on
the radio button so labeled, and give it a Share
Name, colorlaser.

THE LINUX SIDE
After telling your Windows PC to share with its
neighbors, your shared resources should be visible
from your Linux workstation.

If you have the latest version of KDE (3.4.1),
you should see a computer icon on the main KDE
panel. Click on that icon and choose Remote
Places. This opens up a file browser that includes
a Samba Shares icon (Figure 2). Another method
is simply to click on the Konqueror icon on the
KDE panel. The latest versions of KDE will show a
page that includes a Network Folders link. Click
on this link, and you will be taken to a window
much like the Remote Places window.

You can click on the wand to mount a network
folder. For most people, this will be the hard way
to access your Windows shares, because you need
to know the names of servers, workgroups and so
on in advance.

Let’s explore an easier way to access your
Windows shares. In this case, you don’t mount a
network share, you simply add a shared folder to
your desktop. Somewhere during this process, you
may be required to enter a user name and pass-
word, depending on what kind of Windows share
you are accessing and how it was configured.

First, if you have the option to open up a
Remote Places folder or have the Network Folders
link, you can use them to get to the Samba Shares
icon. Click on this icon to start your journey.

If you don’t have a Remote places folder 
or Network Folders link, you can open up a
Konqueror window and type smb:/ in the 
location field.

Either way, this should take you to a set of
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Figure 2. Remote Places

Figure 3. Windows Workgroups in Konqueror

Figure 4. The Family Computer
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icons for each Windows workgroup (Figure 3).
Click on the workgroup your family uses. In

this case, I clicked on Workgroup, which is the
default for Windows installations. This takes me to
the computer icon called Family, which is the
name of the family computer (Figure 4).

Click on this icon. Now you should see the
Windows shares set up on your family computer
(Figure 5). In this case, it shows the default names
for the shared disk drives C: and D:, which it rep-
resents as C$ and D$.

I clicked on the drive D$ icon, and now I can

see all the shared folders on that drive (Figure
6). If there is a particular folder you want to
access frequently, drag the folder icon to your
desktop, and when the menu pops up, click Link
Here. From this point on, all I have to do to get
to the Windows folder is to click on the icon on
the desktop. Just as a reminder, the next time
you boot up Linux and try to access this folder,

you probably will be asked to enter a user name
and password.

THE LINSPIRE WAY
From Linspire, the self-proclaimed “world’s easi-
est desktop Linux”, you should be able to view
them from the Network Share Manager located
on your desktop. This utility is easy enough to
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Figure 5. Shares on the Family Computer

Figure 6. Shared Folders on the Family Computer Figure 7. The Linspire Share Manager
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use that it doesn’t require a tutorial. It is
similar enough to the Windows Network
Neighborhood that it should be intuitive
for any Windows user. Even if you are not
a Windows user, it is fairly obvious that
you simply drill down, from Entire
Network to the workgroup, to the com-
puter and to the folder. Double-click on

the folder you want to mount,
and a dialog box pops up that is
self-explanatory (Figure 7).

You also can access Windows
shares from the Konqueror Web
browser in Linspire by using the
techniques described above. But
Linspire doesn’t make Konqueror
your default browser, so you are
probably better off using the
Network Share Manager.

THE MANDRAKE WAY
If you are running Mandrake
10+, you need to configure your
computer by following the
System menu entry to the
Configuration item and clicking
on the Mount Points option.
Once there, you are given the
opportunity to Set your Samba
Mount Points, providing a utility
to search your available servers
and identify the computer con-
taining the data you want to
share (Figure 8). Double-clicking
on that entry, entering your user
name and password and then

clicking Ok should get you access to
your Windows PC. Clicking on the small
arrowhead to the left of your computer’s
name displays the shared folders existing
on that server. Highlight the folder you
want to access, push the Mount Point
button and complete your mount point
definition. Once you have it defined, you

actually have to mount the drive before
you can access it. Not necessarily a com-
plicated process, but a little more work
than installing your system and finding
your shares already there.

Printer configuration is a little more
standardized, especially if you are running
KDE 3. Simply go to the KDE configura-
tion menu (System→Configuration→KDE),
select the Peripherals option, and choose
the Printers entry to use the Add Printer
Wizard; the same wizard you use when
you add any printer. Advance past the
introduction screen to Backend Selection
where you can indicate you are adding
an SMB shared printer. On the next
screen, click on the Normal Account
radio button and enter your user name
and password. Advance to the next
screen and use the scan button to get 
a list of Windows Work Groups. You 
can follow the arrows on the left,
sequentially clicking on them to bring 
up a list of PCs and then a list of print-
ers and identify the printer you want to
use. From this point on, the process is
the same as a routine printer configura-
tion. You select the make and model of
the printer, set your banners, give it a
name, and now you too are able to use
the color laser.

Hopefully, you now are more than confi-
dent that you can once again have a happy
home with all of your computers playing
nicely together. If only there were a Samba
implementation for siblings.�
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Figure 8. Configure Your Computer with Mount
Points in Mandrake
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In the big-top circus that is the typical office desk-
top, chances are you’ve already become familiar
with the show’s three rings: word processor,
spreadsheet and presentations.

Having used a word processor, you know that one
of the first things you learned was to format para-
graphs: set the font size, apply bold or italic empha-
sis, change colors and adjust the justification. These
are the basics of the word processor, without which
most documents might just as well be plain-old text.

The GIMP has some basic tools too, and some
basic processes to go with them. Without a
doubt, the most important of the basic tools is the
selection. Selections are to GIMP what the whip is
to the lion tamer—a tool for you to maintain con-
trol over your project.

This month, I show you how selections are
more than mere squares and circles. They are the
trapeze from which you’ll swing your mighty act.
Grab a bag of peanuts, find a good seat, sit back
and relax. It’s time for the show to begin.

SIMPLE SHAPES
The most simplistic use of a selection is as a space
to fill. Filling with color is one option. Filling with
a gradient is another. Both are easy to do and
form the basis of many effects.

Open a new window (File→New from the

Toolbox). Click on the Rectangular selection in the
Toolbox. In the Options dialog, make sure the Mode
is set to Replace (the left-most button). Click and
drag from the upper left of the canvas window to the
lower right to create an upright rectangle (Figure 1).

Click on the Gradient Tool in the Toolbox. In the
Gradient Options, click on Shape to Bi-linear and click
on the Reverse button to turn it on. Starting some-
where on the left side of the selected rectangle,
click, hold down the mouse button and drag the
mouse to the right edge of the selection, then release
the mouse button. Voilà—instant cylinder (Figure 2).

Be sure to drag straight across. You can turn on
Snap to Grid (right-click on picture, View→Snap to
Grid) before dragging, and that may help.

RING SELECTIONS
Open a new window. Create a new layer (right-
click on picture, Layer→New). Click on the
Elliptical selection tool. Holding down the Shift
key, click and hold down the mouse button as you
drag it in any direction to create a circular selec-
tion. The Shift key forces the selection to be circu-
lar. If you do not hold down the Shift key, you can
create elliptical or oblong selections.

Notice that the selection expands in the direc-
tion you are dragging the mouse. So, if you plan
to select a circle in the middle of your drawing

area (canvas), you would not start by clicking the
mouse in the middle to create your circle. You are
more likely to get the circular selection you want
by starting somewhere that you expect to be the
edge of your circle. For example, start at where
you expect the upper-left edge of the circle will
be, and drag the mouse down and to the right as
you hold down the Shift key.

Now, back to gradient fills. Click on the
Gradient Tool in the Toolbox. In the Options dia-
log, click on the button that shows the gradient
and let go of the mouse button. A list of gradient

AA  MMaatttteerr  ooff  CChhooiiccee  
((oorr  SSeelleeccttiioonnss,,  TThhaatt  IIss))
Michael explains many ways to be selective with GIMP.

MICHAEL J. HAMMEL

Figure 1. Toolbox, Options, Canvas and Selection

Figure 2. Toolbox, Options, Canvas
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types opens up. Scroll through the list and choose
the Crown Molding gradient. Set the Shape to
Linear. Click and drag across the selection to fill it
with this gradient. Click on the layer name to
name this layer Ring. See Figure 3 as an example
of how your work should appear.

Now, reduce the size of the selection by 10 pixels
(right-click on picture, Select→Shrink). Use Ctrl-X (or
right-click on picture, Edit→Cut) to cut the selection
out of the gradient you just applied. You should now

see a ring instead of a gradient-filled circle.
Click on the Background layer in the Layers

dialog to make it active. Fill the Background layer
with black by dragging the foreground color onto
the layer in the Layers dialog. Because you made
the background active, you also could have
dragged the foreground color onto the picture
itself, and it would have given you the same
result. You should see something like Figure 4.

Click on the Ring layer in the Layers dialog to
make it the active layer. Select the Fuzzy Select
tool from the Toolbox. This is the button that
looks like a wand and says Select Contiguous
Regions if you hover the mouse pointer over it.
Click inside the Ring in the canvas, and it auto-

matically selects the inside of the ring.
Now, create a new transparent layer. You do

this by clicking on the button in the Layers dialog
that looks like a single new sheet of paper. A dia-
log pops up. It should have Transparency selected
by default. Click Ok.

Double-click on the Foreground color box to
open the Change Foreground Color dialog. Click
in the part of the color box that makes the fore-
ground color reddish or maroon. You can experi-
ment and click around until you get the color you
want. Close the color dialog.

Drag the new Foreground color into the selec-
tion. Instant metallic-edged button—like the one
you see in Figure 5.

ODD SHAPES
You can create complex shapes by transforming
and joining common selections. This sounds more
complicated than it is. Here’s how you do it. Open
a new window. Click on the Rectangular selection
tool in the Toolbox. Hold down the Shift key and
drag through the canvas to create a small square
selection (Figure 6). (Holding the Shift key forces
the rectangle selection to be a square, just as
holding the Shift key for the elliptical selector
forces the selection to be a circle.)

Click on the Rotate Transform tool. You can find
it by letting the mouse pointer hover over the tool
buttons until the tooltip says Rotate the layer or
selection. In the Options dialog that appears, set the
Affect option to Transform Selection (it is the middle
button). Click on the canvas to open the Rotate
dialog (Figure 7). Type 45 in the Angle field, because
that is the most accurate way to rotate the selection
45 degrees. Click on the Rotate button.

Click on the top ruler, hold down the mouse but-
ton and drag a Guide line from the top ruler down
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Figure 3. Toolbox, Gradient, Options, Canvas

Figure 4. Canvas, Layers Dialog

Figure 5. Canvas, Toolbox, Layers Dialog, Change
Foreground Color
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until it intersects with the left and right corners of
the rotated box. Click on the Rectangular Tool in the
Toolbox. In the Options dialog, click on the Subtract
Mode (third button). Point the mouse to the left end
of the guideline, and drag a selection downward
whose top runs along the Guide and completely
through—left to right—the bottom half of the rotat-
ed selection. This should leave you with a triangular

selection on top. Scale it and squeeze it using the
other Transform tools in the Toolbox (Figure 8).

SHAPING YOUR VIEW
We’re now going to make a picture of a 
magnifying glass.

Click on the toolbox to make it the active
window. Type the letter D, which resets the
color boxes to black and white.

Open a new window and create a new layer
(right-click on picture, Layer→New, then click
Ok). Choose the Rectangular Selection tool from
the Toolbox. In the Options dialog, click on the
first rectangle button to reset the mode to
replace the current selection. In the same dialog,
find the button that says Free Select, click it and
change it to Fixed Size. Set the width to 30 and
the height to 10. Click and drag in the canvas. 
A presized selection appears (Figure 9).

Open the Gradient tool. Click on the gradient
button and select FG to BG (RGB) from the list of
possible gradients. Set the Shape to Linear if it is
not already set that way by default. Drag through
the small selection from bottom to top. Remove
the selection (right-click on picture, Select→None,

or Ctrl-D). Click on the Move tool (the crossed
arrows button), and select Move the current layer
in the Options dialog. Drag the layer to the right
side of the canvas.

Create a new layer. Choose the Rectangular
Selection tool from the Toolbox. In the Options dia-
log, set the type to Fixed Size, the width to 175 and
the height to 30. In the canvas, click and drag. A
presized selection appears. Open the Gradient tool,
set the gradient to FG to BG (RGB) and the shape to
Linear. Drag through the small selection from bot-
tom to top. Remove the selection the same way you
did before (right-click on, picture Select→None, or
Ctrl-D). Click on the Move tool (the crossed arrows
button) and select Move the current layer in the
Options dialog. Use the Layers dialog to activate the
two layers with the gradient rectangles, and work
with them until the large rectangle overlaps the
small as shown in Figure 10.

Click on the top layer in the Layers dialog and
merge the two gradient layers (right-click on pic-
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Figure 6. Toolbox, Canvas

Figure 7. Toolbox, Canvas, Options

Figure 8. Canvas, Options Dialog

Figure 9. Canvas, Options Dialogs
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ture, Layer→Merge Down). Double-click on the
layer name, type Handle and press Enter.

You want to select this handle such that you
can move it around. Here’s how to do that. To
select only the handle, right-click on picture,
Layer→Merge Down Layer→Alpha to Selection.
Copy this selection (Ctrl-C) and then paste it

(Ctrl-V). Now that you have a floating handle
selection, make this floating selection a new layer
(right-click on picture, Layer→New). Delete the
original Handle layer. Name the new layer Handle.

Click on the Rotate tool in the Toolbox. Click on
the canvas. In the Rotation Information dialog type
-30 in the Angle field. Click the Rotate button to
apply the rotation to the handle (Figure 11).

Create a new layer (right-click on picture,
Layer→New). This next part should be familiar to
you because we’ve done it before. Click on the
Elliptical selection tool. Holding down the Shift
key, click and drag to create a circular selection.

Click on the Gradient tool in the Toolbox. In the
Options dialog, click on the Gradient button and
choose the Crown Molding gradient and set the
Shape to Linear. Click and drag across the selec-
tion to fill it with this gradient. Click on the layer
name to name this layer Ring (Figure 12).

Now reduce the size of the selection by 10
pixels (Select→Shrink). Use Ctrl-X to cut the
selection out of the gradient you just applied.
Click on the Handle layer in the Layers dialog.
Drag that layer to intersect with the Ring layer.
Move the Ring layer if needed (Figure 13).

I’ve taken this example a bit further by adding
a puppy layer and using the Lens filter (Filters→
Glass Effects→Apply Lens) to warp the face a little
(Figure 14). Much of this project focused on using
selections: the handles, the lens ring and the dis-
torted face. As you can see, selections are an
important tool in your GIMP toolchest.�

Michael J. Hammel is an author, graphic artist, Web designer
and software developer currently working for RLXTechnologies
in Houston, Texas. He has spoken at the ALS, LinuxWorld and
SXSW conferences, and chaired multiple conferences on Linux
in Colorado. He is the primary maintainer for the MiniMyth
build system, and he runs XEUS, his own development site for
XNotesPlus, Ximba Radio and other open-source software. He
can be reached at mjhammel@graphics-muse.org, and his blog
is at http://www.ximba.org/wordpress.
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Figure 11. Canvas, Toolbox, Rotation Dialog

Figure 12. Ring Layer

Figure 13. Magnifying Glass

Figure 14. Final Puppy

Figure 10. Canvas, Options Dialogs
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I’ve tried just about every Linux distribution
whose name most people would recognize
and then some: Red Hat, Fedora, SUSE,
Mandriva (formerly Mandrake), Debian,
Knoppix/Gnoppix, Mepis, PCLinux OS,
Xandros, Ubuntu/Kubuntu and more. None
of these alternatives rival Linspire, formerly
Lindows, for ease of use, especially for
those who make the transition from
Windows to Linux. The folks at Linspire
have a unique understanding of what it
takes to make average users comfortable
with their desktop. The average Linux desk-
top has come a long way, but it is still per-
meated with user interface decisions made
by self-absorbed geeks who have no idea
how normal people want to use comput-
ers. Linspire has identified most, if not all of
these shortcomings, and has addressed
them in one way or another.

For example, Linspire includes a
remarkable tool called Click-and-Run
(CNR). CNR is an installation tool that lets
you add and remove packages from your
system. You can install both free and
commercial packages from CNR.

CNR organizes all the available applications for
Linspire in categories that people are most likely to
understand. For example, you can click on Audio &
MP3 and CNR presents you with a list of available
packages, plus links to subcategories. You don’t

have to click on an application name to find infor-
mation about what it is or what it does, because
the description shows up along with the package
name itself (Figure 1). If you see an application you
like, you simply click on a little green button and
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CNR installs the package immediately. There’s no
dialog box that lists all the dependencies (other
packages) your selection needs, and it will install
these in addition to the application you want. A
nongeek user is going to say, “Who needs that
sort of thing, anyway? Just install the program
and don’t bother me with the details.”

I was expecting the Linspire CNR warehouse to
have a terribly limited assortment of available appli-
cations, but I was surprised to find almost everything
I wanted in the warehouse. It even had avidemux,
which is a fairly obscure but useful open-source pro-
gram for manipulating AVI videos. I’ve had trouble
finding it for other distributions, and as far as I can
tell, I can’t even get it at all for Ubuntu Linux without
breaking things or compiling it myself.

CNR REMEMBERS
You also can purchase commercial programs and
install them automatically from CNR. And here is
the icing on the cake: Linspire’s CNR remembers
what you pay for and install. If, for some reason,
you must switch computers and re-install Linspire
from scratch, CNR remembers what you installed
before (based on your account and registration
details). This means you can bring your new system
up to date with all the software you chose before
with very little trouble. You also can re-install com-
mercial packages like Photogenics immediately,
without having to pay for them again. Linspire CNR
remembers that you already paid for this package.
In fact, even if your subscription to CNR runs out,
you can still re-install Photogenics for free as long as
you paid for it when you had a valid subscription.

THE ALTERNATIVES
The only way to appreciate fully the advantages of
CNR is to compare it to other package managers.

Desktop users inevitably will want to install some
new software or update their existing software.
There are some remarkably easy package man-
agers available for Linux these days that handle
these tasks. Xandros has a custom, easy-to-use
package manager that is similar in some ways to
the Linspire approach. Kpackage is not customized,
but it is standard with KDE and is practically a
work of art. However, even these similar tools pale
in comparison to Linspire’s CNR program.

The problem with programs like Kpackage (and
in some cases, the Xandros custom installer) is that
it is really just a skin-deep front end for the distrib-
ution’s package system. So, Kpackage “thinks”
pretty much the same way the distribution’s pack-
age system works. No distribution has an intuitive
packaging system, and that deficiency always man-
ages to leak into the way Kpackage works. For
example, a Kpackage front end to Debian organiz-
es packages the Debian way, which is not user-
friendly. The categories of packages include things
like X11, tex and python. Grandma simply isn’t
going to get that. Xandros organizes its packages
better, and it gives you the chance to install pack-
ages with a single click. But it is not nearly as fea-
ture-rich nor as easy as Linspire’s CNR program.

PAY FOR FREE SOFTWARE?
Users who are already savvy about Linux will
cringe at the thought of having to subscribe to a
CNR service to download and install open-source
programs they can get for free, but Linspire isn’t
made for those users. The rest of the world will
find it worth every penny for the convenience.

Right now, you can get a short, free trial sub-
scription to CNR with every purchase of Linspire.
During this time, you can download as much free
software as you like. In fact, if you want to

“cheat” Linspire out of their subscription fee, you
can download every free package you can find
before your free trial expires.

The subscription fee for CNR is roughly $50 per
year. Right now, you get two extra benefits for this
price. First, you get technical support from Linspire.
You also get hefty discounts on commercial software
that you can download with CNR. I purchased
Photogenics for $19.95 through CNR. The retail price
for Photogenics is $79. If I found a few more com-
mercial packages for Linux to be appealing, both
Linspire and CNR would pay for themselves very
quickly in the discounts I get just for using Linspire.

Linspire hints that the subscription fee may
change in the future. Linspire is considering lower-
ing the CNR subscription fee by removing the sup-
port option from it. You pay less every year for
CNR, but you still get the discounted prices on
commercial software. What you do not get is sup-
port from Linspire. If you want that, you’ll have to
pay the full $50 per year. None of this is official
yet, but it is likely that Linspire will move to a dif-
ferent pricing model like this one. If Linspire does
reduce the yearly fee for CNR alone and still offers
discounts on commercial software, that would
make CNR truly unbeatable in the market.

LINSPIRE “GETS IT”
Here’s another example of how Linspire improves
the user experience. digiKam is a feature-rich and
powerful photo manager you can get for any dis-
tribution. But intuitive, it is not. Linspire offers its
own equivalent program, Lphoto.

Just compare the two screenshots, one of
digiKam (Figure 2) and one of Linspire’s Lphoto
(Figure 3), and the difference should be obvious.
Anyone who fires up Lphoto can see instantly how
to e-mail photos, print them, set one as the desktop

REVIEWS

51www.tuxmagazine.com

http://www.tuxmagazine.com


background or view the current library as a
slideshow. Why? There are big buttons at the bot-
tom of the window for each of these common tasks.

Do you want to crop a picture or remove red-
eye from a portrait shot? Click on the Edit tab,
and you will see big buttons for these kinds of
tasks (Figure 4).

Even operations like burning photos to a CD or
making a screensaver are easy to find. They’re not
big buttons—they appear in the main menu, but
that’s hardly worth a complaint.

Now, have another look at digiKam and ask
yourself if you see from the picture how to e-mail
a picture or group of pictures, how to set one as
your desktop wallpaper or how to perform any of
the tasks mentioned above.

The point is that Linspire “gets it”. Most people
don’t want to learn how to use a program like
digiKam, no matter how powerful it might be. They
want to download and organize their photos, print
them, send them by e-mail and so on. They don’t
want to browse menus or read a tutorial on how to
e-mail a photo. They want a big button that says
Email. This is the kind of approach Linspire takes to
all its modifications and additions.

(As an aside, Linspire made Lphoto open
source, so you can get Lphoto installed and work-
ing in other distributions, but it’s usually not easy
to find the source or install it.)

A BETTER WINDOWS THAN WINDOWS
Linspire hasn’t copied Windows down to the last
detail, and that should come as a relief to all
users, both Windows fans and Linux fans. But
Linspire has made the default desktop configura-
tion very Windows-like in many ways. For exam-
ple, the desktop is based on KDE, where you nor-
mally single-click an icon to activate it. You have

to double-click icons on the Linspire desktop, just
as you would in Windows.

Linspire doesn’t give you any virtual desktops by
default, because virtual desktops can be confusing
to new users, especially if they are already used to
Windows. But Linspire doesn’t stop a savvy user
from changing these defaults. You can switch to
single-click icons if you want, and you can add vir-
tual desktops if you want. But the default configu-
ration is a clever way to make the desktop as
friendly as possible to ex-Windows users.

Linspire has adapted full-blown Mozilla for e-
mail, browser, address book and scheduler. I
expected to snub this combination at first in favor
of Firefox and other tools. But once I started using
the Linspire suite, I found it quite irresistible. I’m
even thinking about adopting this approach with
other distributions. Naturally, Linspire includes
OpenOffice.org as its office suite.

Linspire also comes with more device drivers
than I have found in any other distribution. For
example, my Linksys WUSB wireless adapter
worked perfectly, the first time. I know of no
other distribution that supports this USB wireless
adapter out of the box. I have to compile my own
drivers for every other distribution I have tried,
and as of this writing, the latest source code for
the USB wireless adapter doesn’t work with the
latest Linux kernels.

THE DOWNSIDE
Linspire is far from perfect just yet. The installation
process does help you create a normal user, but it
is far too easy to use Linspire as root (the
Administrator) by default. The folks at Linspire
may even work this way themselves, because at
least one Click-and-Run application I installed
wouldn’t finish the configuration step until I
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Figure 2. digiKam Photo Manager

Figure 4. Lphoto Edit Options

Figure 3. Linspire’s Custom Photo Manager,
Lphoto
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logged in as root and installed it from there. This
is one thing Ubuntu gets right and Linspire gets
wrong (probably in an effort to emulate Windows
XP, which is poorly designed). Ubuntu does not
even let you create a root user password, and it
prohibits you from logging in as root. If Linspire
took this approach, it would come that much closer
to being the perfect newbie distribution.

Another downside to Linspire is that if you
upgrade to a new version or re-install Linspire over
the existing installation, you still have to re-install
all the CNR applications you installed previously.
These applications actually exist on your hard
drive, but the Linspire desktop doesn’t know
about them until you re-install them. Fortunately,
CNR keeps track of all the packages you installed,
and keeps track of them off-line. So, you can re-
install everything you had installed before, and do
so quickly and easy. As mentioned before, you do
not have to worry about paying twice for the
same commercial package. CNR remembers what
you paid for.

VERSION CATCH-UP
There is always a trade-off you have to make
when you customize a desktop like Linspire has
customized KDE. It keeps your distribution at least
one or two versions behind the current version.
Linspire’s desktop is based on KDE 3.3.2.

It is debatable as to whether this drawback is
the fault of the Linspire or the KDE folks. If KDE
were already intuitive enough as it is, companies
like Linspire wouldn’t have to modify it to make it
easier for the novice user. The question is whether
the modifications are really necessary. That you’ll
have to decide for yourself if you buy Linspire.

I happen to think Linspire has it right, and KDE
needs to pay attention to at least some of the

changes Linspire made. In fact, Linspire is so desir-
able that I have been tempted to switch to it as
my default desktop despite the fact that I would
have to give up using the latest KDE. This is saying
a lot. I am obsessive-compulsive about using the
latest software. I am the kind of Linux user who
measures the age of the software I use in hours,
not version numbers.

You can boot the Linspire CD as a live CD. This
is nice, but I don’t quite see the point. If you
bought Linspire, you might as well install it. Most
Linux distributions are easy to install these days.
Linspire was a little easier than others, but not so
much as to make a fuss about it. And as with all
distributions, your mileage may vary. Even
Knoppix—known for its massive support for
almost every computer imaginable—doesn’t install
well on some machines. So there is no guarantee
that everyone will have a problem-free installation
of Linspire. This is where it will come in handy
that you have to buy Linspire. You can call the
company and get support.

Finally, I was excited at first when I saw that
Linspire includes full-screen narrated tutorials. The
tutorials are really sharp and professional looking.
But I was a little disappointed when I found out
that only the first, most basic tutorials are narrat-
ed. The other tutorials, such as the one on how
to set up a network card, are good enough that
you don’t need the narration to learn what to do,
but it still seemed a little cheesy to boast about
narrated tutorials if they’re not going to narrate
all of them.

CONCLUSION
Well, it’s time to get to the inevitable controversy.
You can’t get Linspire for free. (Well, it’s just as
“free” as Windows if you buy a PC with Linspire

pre-loaded, and Linspire is making more and
more pre-load deals all the time—but that’s
another story.) You have to buy Linspire. You can
download a copy for $49.95, but most of the tar-
get audience for Linspire will want to purchase a
box for $10 more. You don’t get much more for
that $10 besides the convenience of not having
to download an image file and burn a CD. There
isn’t much in the box that makes it worth $10
more except the convenience of having a pre-
made CD. You get a short, free trial of CNR, and
you can download a warehouse full of software
during that time. After that, you have to pay
$49.95 per year to use CNR. (Though, as men-
tioned previously, this rate may become dramati-
cally less if you want to opt out of getting sup-
port from Linspire.)

If you intend to pay for a good number of
commercial products for Linux, such as
Photogenics or Moneydance 2005 (a Quicken-like
program for Linux), Linspire and your CNR sub-
scription will eventually pay for themselves in the
discounts you get for these products. Some com-
mercial products are totally free only to CNR sub-
scribers, making the deal even sweeter.

The bottom line is that if you are savvy
about Linux, Linspire probably isn’t for you. But
if you are a novice desktop user, or a nongeek
who is used to Windows and wants to switch
to Linux, Linspire is, hands down, the ultimate
distribution. The competition, if there is any
distribution worth calling competition, doesn’t
even come close. You will find that both
Linspire and the CNR subscription are worth
every penny.�

Ricky Freedlander is a consultant and freelancer and has been
using Linux since 1995.
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One of the nicest things about the bulk of today’s
new digital cameras is that they’ve dispensed with
the proprietary software previously needed to
move your images from the camera to your PC.
Although the software often added a few nifty fea-
tures to a Windows-based computer, it also tended
not to be overly friendly with other operating sys-
tems, which meant that Linux users had to use
alternative methods for retrieving pictures.

Now, most cameras act as “storage-class”
devices when you plug them in to a computer
with the USB cable. This means it no longer mat-
ters what type of machine you’re plugging the
camera in to—Windows, Mac or Linux—the
newest generation of digital cameras should act
just like any other external media, and you can
drag and drop your photographs into the appro-
priate folder right on your computer.

This month, I take a look at a pair of new
digital cameras designed to connect to your PC
this way. Fire up your favorite photo editor and
manager—there’s photography afoot!

FUJIFILM FINEPIX F10

http://www.fujifilm.com
$400 US

FujiFilm has long been touting the benefits of
its 6.3 megapixel SuperCCD imaging sensor, and
the F10 is the company’s new high-end consumer
model. It comes with a 3x optical zoom, and

there’s a large 2.5-inch optical viewfinder on the
back of the camera, but the whole thing checks
in at a svelte 90 x 57 x 28mm. (One casualty of
the compact design is the optical viewfinder,
which is omitted completely on the F10.)

The camera is surprisingly powerful for such a
compact model. Startup time is very quick, giving
you the ability to take your first shot within five sec-
onds of pressing the power button. A quick flick of
the mode dial—located around the shutter button—
moves you quickly between automatic, manual,
movie and scene position mode. The last of these
modes lets you switch between portrait, landscape,
action, night-shooting and “natural light” modes.
Natural light mode is my favourite, as it allows you to
take pictures in low light conditions without having to
use the flash, so you can get good shots with both
foreground and background items clearly visible.

Although the camera takes great pictures in a
variety of conditions, a couple things aren’t ideal
with the F10.

First is the camera’s occasional tendency to focus
really, really—and I mean painfully—slowly when
you’re in macro mode; it’s almost like you can hear
the miniature workers inside heaving-ho and yanking
on the pulleys to get all of the optics in place. Ow.

The second is the use of a nonstandard connec-
tor on the side of the camera to provide both USB
connectivity and power. It’s a nice way to tame the
cable sprawl on your desktop, but it means that
any time you want to connect the camera to a
computer, you’ll need the special adapter brick
that hooks to both the USB and power cables.

The camera comes with a 16MB xD card for
picture storage, so you’ll definitely want to invest
a bit of extra money in a higher-capacity card.
With 512MB cards at about $80 and 1GB cards at
$120, you’ll want to buy as large a card as you
can afford, because once you start shooting with
the FinePix F10, you won’t want to stop.

NIKON D50

http://www.nikon.com
$900 US

Photography fans who come from the 35mm
film camera school will almost certainly want to
check out one of the growing numbers of digital
SLR cameras available these days, but the question
is...where to start?

If you’ve never played with an SLR before—
either digital or film-based—the big selling point is
control over your image. First of all, SLR stands for
Single Lens Reflex, which means that what you see
through the viewfinder is what you get when you
press the shutter. There are a series of mirrors inside
the camera that allow you to look directly through

GGaaddggeett  GGuuyy::  SSnnaapp  SSnnaapp!!
SEAN CARRUTHERS
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the lens when you frame your image, as opposed
to a smaller window located beside the lens.
There are other factors involved that can make
this untrue, but in general, an SLR is a “what
you see through the lens is what you will get
for your final picture”.

Anyway, if you’ve already built up a
collection of Nikon lenses for your old
film camera, the Nikon D50 is a great
value-conscious option.

Although Nikon also has a few digital
SLR models aimed at more professionally
inclined photographers, the 6.1-megapixel
D50 is designed for the SLR-curious digital
photographer, with a slightly scaled-back feature
set and a scaled-back price to match.

In addition to the 18–55mm lens that comes with
the camera, the D50 is also designed to work not
only with any of Nikon’s new digital lenses, but also
with the growing number of the company’s old-
school analog lenses designed for the Nikon F-mount
system. (Note: the old-school lenses won’t provide
full automatic functionality and won’t send digital
information back to the camera for storage as meta-
data inside the image files, but if you’re willing to do
manual work on both the zoom and focus rings, you
can use the old lenses just fine.)

Secondly, though digital SLRs give you a wide
range of automatic shooting modes, you also have
the ability to flip into manual mode quickly and
change your settings by hand, including focus, aper-
ture, shutter, white balance, ISO equivalency and
more. True, you can change some of these things
with point-and-shoot models, but the process is
often very odious. With digital SLR, it’s often as easy
as brushing your thumb against a jog wheel.

The Nikon D50 does a pretty good job of bal-
ancing the manual and automatic capabilities,

which makes
it a great
choice for
those just
wading into
the world
of digital
SLR. You
can go
almost fully
automatic
at the start, but
as you become more familiar with what the con-
trols do, you can delve in as far as you like.

There’s a mode wheel on the top left-hand
side of the camera, and in addition to the major
manual options (program, shutter-priority, aper-
ture-priority and full manual), there’s also a full-
automatic mode so that you don’t have to worry
about any settings. Additionally, there are a few
scene modes, for shooting under very particular
conditions, like portrait shooting, landscape,
action, close-up/macro, night shooting and a

special setting for those trying to photograph
active children. Moving between modes is as
easy as changing the position of the dial—no
need to burrow around in an onscreen menu
system looking for the right settings.

Manual focus is a bit trickier with the D50.
There are two switches—one on the body of the
camera and the other on the side of the lens—for
switching between manual and automatic focus.
The real problem with the camera’s manual focus
capabilities is the tiny focus ring located at the
very tip of the bundled lens. It’s not an ideal loca-
tion. First, it makes fine focusing work more diffi-
cult than with a lens that has a larger focus ring
placed further back on the lens; second, if you’re
not exercising caution, you could inadvertently
smudge the lens with the oil on your fingertips.

As with the vast majority of digital SLR cam-
eras, the Nikon D50 doesn’t come with a memory
card, so you’ll have to budget a bit extra. The D50
breaks with digital SLR tradition, however, as it
uses SecureDigital memory instead of the more
commonly used CompactFlash. Make sure to get
one of the higher-performance SD cards, though,
so the card doesn’t become a performance bottle-
neck; it’s well worth the price difference.�

Sean Carruthers is a freelance technology
journalist from Toronto. He spent six years
at Canada Computer Paper, first as
Products Editor at The Computer and later
at HUB Digital Living magazine. As a free-
lancer, he has written for the Globe and
Mail, http://globetechnology.com, HUB
Digital Living, Computer Dealer News,

Homefront and CE-Biz. Although a relative newbie with Linux
(SUSE, thank you very much), he has extensive experience with
tech gadgets of all sorts and is enjoying figuring out which ones
are compatible with Linux.

REVIEWS

55www.tuxmagazine.com

http://globetechnology.com
http://www.tuxmagazine.com


digiKam is digital photography tool
that interacts with your digital cam-
era to import, edit and manage your
digital pictures.

It is able to autodetect a large
number of digital cameras, manage
and organize different photo albums,
perform image manipulations and
even export your albums as photo
galleries to publish on the Web.

digiKam has been around for a
while and is definitely one of the
most advanced photo management
tools for the Linux desktop today.

The main dialog features an
expandable tree of albums on the
left, and the main panel is used to
display thumbnails of all the images
in the selected album. Placing your

mouse over any of the thumbnails
will display additional information
about the associated picture.

digiKam also supports some inter-
esting plugins for export of your
photos as a calendar, batch image
manipulations, a slideshow tool that
creates MPEG slideshows for your
photos and much more.

The application is pretty
straightforward to use. Typically,
you will plug in your digital camera
to the USB port of your computer,
then click on the Camera menu
entry, then select the Add Camera
entry. Clicking on the Auto Detect
button at this point typically
detects your digital camera and
adds it to the list.

After clicking the OK button, a
camera import wizard shows up. You
can use that wizard to select the pic-
tures you would like to import from
your camera and select an album
where they should be imported.
Optionally, you may choose to have
digiKam automatically delete the
photos from the camera once they
have been completely imported.

On the editing side of things, the
built-in editor that comes with
digiKam does a pretty good job of
most of the little tasks I frequently
need after importing pictures.
digiKam offers cropping, rotating and
scaling tools, a red-eye reduction fil-
ter and a few color filters to apply
color effects such as sepia, black &

white and so on, to your photos.
Overall, I found digiKam to be a

perfect all-in-one solution for import-
ing, editing and managing photo
albums from all my digital cameras
over the last few years. It performs
well, looks great and the user inter-
face is intuitive.

— X a v i e r  S p r i e t
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digiKam

About digiKam:

• License: GNU General Public
License (GPL)

• Price: Free
• Web site: http://www.digikam.org

digiKam Photo Import tool

Main digiKam Window
Photo Editor

http://www.digikam.org
http://www.tuxmagazine.com


The OpenOffice.org office suite appears
to be getting close to a 2.0 version,
with beta versions available on the
Openoffice.org Web site for the last
few months. I decided to look at what
was in store for us, so we can all know
what to look for when the final release
comes up.

This month, I take Impress 2.0 (build
1.9.110) for a spin.

I had a few issues with the 1.x versions
of Impress in the past, but I have to say I
am quite impressed by the 2.x series of
builds. The user interface is quite smooth
and looks a lot better on the GNOME
desktop than it used to.

Looking beyond the new, polished
user interface, you will be pleasantly
surprised to find a much-improved
Microsoft PowerPoint compatibility in
place. I was able to import large files
quickly and complex presentations with
no effort, and the reverse operation
was just as straightforward.

Additionally, I was able to export my
presentation as a Macromedia Flash file,
which in turn allowed me to integrate a
multimedia presentation to a Web docu-
ment that everyone can read with a Web
browser. This feature was already part of
Impress in previous versions.

Impress features a presentation wiz-

ard that will help you get started while
creating a new presentation.
Additionally, a plethora of import and
export formats are also supported.
Although the major ones will be the
Microsoft PowerPoint format, the new
Oasis Open Document format and the
Flash export filter, others are also pro-
vided such as PDF, HTML, various
graphic formats and so on.

One issue that I originally had with
most OpenOffice.org applications was
the small amount of templates that
shipped with the applications. After 
all, I don’t necessarily want to design 
a new template from scratch every time
I want to come up with a new personal
presentation. I was quite thrilled when 
I noticed that OpenOffice.org supports
the import for Microsoft Office tem-
plates as well. I was able to copy my
entire collection of Office templates
into my OpenOffice.org templates 
collection and use them for all subse-
quent documents.

— X a v i e r  S p r i e t
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Impress

About Impress:

• License: Sun Industry Standards Source
License (SISSL), GNU General Public
License (GPL) and LGPL.

• Price: Free
• Web site: http://www.openoffice.org/

product2/impress.html

The Impress User Interface

A Flash Presentation

http://www.openoffice.org/
http://www.openoffice.org/product2/impress.html
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Whether your current project is professional or
personal, short- or long-term, simple or com-
plex, Planner facilitates the process of manag-
ing your project.

Like many project management tools, Planner
lets you break down your project in tasks and
phases. Individual tasks also can be broken down
into sub-tasks, with a very flexible hierarchy.

For each task, Planner
allows you to specify the
duration, completion rate,
priority, human or material
resources assigned to the
task, as well as notes and
precedence relationships
with other tasks.

The first panel of the
interface features a task
manager and a Gantt-chart.
Any change to the project’s
tasks are reflected immedi-
ately on the Gantt chart. It is very important to
specify the precedence relationships between
tasks correctly; otherwise, the Gantt chart shows
all your tasks scheduled at the same time.

Planner also allows you to manage the
resources (whether human or material) allocat-
ed to a project. Specifying a cost for each
resource also lets planner provide you with a
cost estimate for material and labour broken
down by tasks and sub-tasks.

It is also worth mentioning that if at any
point, the user interface of Planner seems con-
fusing or you are not sure what goes where,

Planner features a good user guide that illus-
trates most of the concepts involved. Click on
the Help menu entry and select the User Guide
to find out more.

Once resources have been created through
the Resources Management panel of the appli-
cation and properly assigned to individual
tasks, you can visualize the utilization of all the
resources allocated to the project through the
Resources Usage chart.

Additionally, Planner supports the export of
complete projects into an
HTML report, which you can
upload to any Web server and
instantly publish on the Web.
This is especially useful if you
want to provide your cowork-
ers with a report on the status
of the project and they do
not have Planner installed on
their system.

Finally, Planner allows you
to import Microsoft Project
XML files. Microsoft Project is

an advanced project management application
that is widely used by project managers in the
workplace. The ability to open files created with
Microsoft Project provides a better level of col-
laboration between multiple project managers.

— X a v i e r  S p r i e t
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Planner

The Gantt-Chart and Task Editor

Resources Usage Chart

About Planner:

• License: GNU General Public License (GPL)
• Price: Free
• Web site: http://developer.imendio.com/wiki/

Planner

Task Creation Dialog

http://developer.imendio.com/wiki/
http://developer.imendio.com/wiki/Planner
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XChat is an IRC (Internet Relay Chat)
client. It allows you to connect to any IRC
server and join channels (chat rooms). IRC
networks are a great way to find people in
your area or with similar interests, but it
also represents a great way to get support
for your favourite Linux distribution.

The way IRC works is that chat takes
place on different networks. Each network
typically represents a fair amount of IRC
servers. But each network has no logical
link to any other IRC network. This means
that typically, a channel named #linux on
one specific network will be totally unrelated to a
channel named #linux on any other IRC network.

Now that we’ve covered the high-level basics
of what IRC is, let us look more closely at XChat.

The first time you run XChat, the program
prompts you to configure some key settings, such
as the user name you would like to use, as well as
alternate user names in case the one you were
originally aiming for is already in use.

Once you have selected the user name, you
must select a network. Most open-source projects
have official support channels set up on the
Freenode network, so I recommend you start off
by using that one.

Once connected to a server, you can find channels
that are of interest to you by clicking on the Window
menu entry and selecting the Channel List entry. This
allows you to search the entire list of channels on that
server for a specific keyword or pattern.

XChat lets you connect to multiple IRC net-
works within one session. You can then join as

many channels as you would
like for each of your current
network sessions. Additionally,
XChat supports sending and
receiving files through IRC, chat
area transparency, plugin sup-
port, event notifications, con-
nections to SSL-enabled IRC
servers (for encrypted chat ses-
sions), a URL grabber dialog
that gathers all links pasted in
any channel you are sitting in, text auto-replace
(useful for common typos), configurable dialogs
and much more. XChat offers all the useful fea-

tures one would expect from an IRC client in a
non-intrusive way.

— X a v i e r  S p r i e t
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XChat

About XChat:

• License: Gnu General Public
License (Linux version only)

• Price: Free (for Linux)
• Web site: http://www.xchat.org

XChat Channel List

Main XChat Window

XChat Server List

http://www.xchat.org
http://www.tuxmagazine.com
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